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Acoustic Doppler Solutions  
 

 

WinRiver User's Guide 
 

1 Introduction 
WinRiver is RDI’s real-time discharge data collection program.  This pro-
gram creates a configuration file to operate the ADCP, checks each com-
mand, and verifies that the ADCP has received the commands.   

Making accurate discharge measurements is less difficult than you probably 
believe now.  You will soon see that you need to use only a few keystrokes 
on the computer to collect data in the field.   

Please take the time to read this entire manual.  It will be useful to have the 
ADCP and a computer available to follow along.  You may also want to 
keep the other ADCP Technical manuals handy for reference when you 
want more detail. 

 
NOTE.  This guide covers version 1.03 or higher. 

 

1.1 System Requirements 
WinRiver requires the following: 

• Windows 95®, Windows 98®, or Windows NT 4.0® with Ser-
vice Pack 4 installed 

• Pentium class PC 233 MHz (350 MHz or higher recommended) 

• 32 megabytes of RAM (64 MB RAM recommended) 

• 6 MB Free Disk Space plus space for data files (A large, fast hard 
disk is recommended) 

• One Serial Port (two or more High Speed UART Serial Port rec-
ommended) 
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• Minimum display resolution of 800 x 600, 256 color (1024 x 768 
recommended) 

• CD-ROM Drive 

• Mouse or other pointing device 

1.2 Software Installation 
To install WinRiver, do the following. 

a. Insert the compact disc into your CD-ROM drive and then follow the 
browser instructions on your screen.  If the browser does not appear, 
complete Steps “b” through “d.” 

b. Click the Start button, and then click Run. 

c. Type <drive>:launch.  For example, if your CD-ROM drive is drive D, 
type d:launch. 

d. Follow the browser instructions on your screen. 

1.3 Communications Setup 
When WinRiver is first started in the Acquire mode, you must set up the 
communications with the ADCP, GPS (if used), External Heading (if used), 
and Depth Sounder (if used).  Once setup, WinRiver will remember the set-
tings and use them each time the program is started. 

a. Connect and power up the ADCP as shown in the appropriate ADCP 
User's Guide.  

b. Start WinRiver in the Acquire mode.  If you are in the Playback mode, 
click File, Acquire Mode.  To open the Communications Settings dia-
log box, click Settings, Communications.   

 
NOTE.  If this is the first time the Acquire mode is started, you will be 
prompted to configure the communication settings.   

 

 
c. Press the Add button.   
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d. Select the device you want to setup and press Next.   

 
e. Select the COM port that the device is connected to.  If you are unsure 

of the setting, use Auto Detect.  Only the communication ports installed 
and available on your system will be displayed.  Press Next to continue.   

 
f. Select the baud rate, parity, and stop bits.  If you are unsure of the set-

tings, use Auto Detect.  Click Next to continue.  WinRiver will connect 
to the device and confirm the communication setting.   
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Figure 1. Communications Port Setting Screen 
g. To temporally inactive a device, click on the device to be inactivated 

and click the Properties, General tab.  Select the Inactive box.  The 
device would not be used during data collection, but its’ parameters 
would be remembered.    

h. On the Properties, General tab there is another option for the ADCP to 
use the "===" string instead of a break.  Only Rio Grande firmware 
10.05 and above accepts this option. 

2 Customizing WinRiver 
WinRiver can be customized to look and act, as you prefer.   

2.1 General Preferences 
a. You can change the size of the fonts in windows by right clicking on the 

widow and selecting Properties.  Choose the font for labels and data.   

b. On the Settings menu, click Units.  You can switch the displays be-
tween SI (metric) and English units. 

c. On the Settings menu, click Reference.  Select the desired reference: 
Bottom Track, GPS (GGA), GPS (VTG), or None.   

 

NOTE.  If the wrong reference is selected during Playback, data may not 
display.  For example, if you select GPS (GGA) as the reference during 
Playback and this was not collected when the data file was created, no 
data will display. 

 



 WinRiver User's Guide 

P/N 957-6171-00 (June 2001) page 5 

2.2 Workspace 
A Workspace is a collection of windows arranged and sized, as you prefer.  
To create a Workspace file, open all the windows you want to see during 
data collection.  Open and arrange the views you are interested in.  When 
you have the displays set up the way you prefer, on the File menu, click 
Save Workspace File.  You will need to do this step for both Playback and 
Acquire modes.  To return to the default workspace, on the File menu, click 
Open New Workspace.   

2.3 Shortcut Keys 
Use the shortcut keys to quickly perform tasks. 

Table  1: WinRiver Shortcut Keys 
Key Description 
F1 Help 
F3 Configuration Setting menu 
F4 Acquire mode = Start/Stop Pinging, Playback mode = Start/Stop Play 
F5 Acquire mode = Start/Stop Transect, Playback mode = Next Data File 
F6 File subsection (Playback mode only) 
F7 User Options 
F8 Configuration Items 
F9 Toggle Ensemble Header and Tabular view 
F11 Swap Composite Tabular view and Discharge Detail Tabular 
F12 Toggle Discharge History Tabular view 
Ctrl-A Output ASCII data file (Playback mode only) 
Ctrl-C Copy 
Ctrl-L View Command Log (Acquire mode only) 
Ctrl-M Switch to Acquire/Playback mode 
Ctrl-N New Configuration File 
Ctrl-O Open ADCP Raw Data File (Playback mode only) 
Ctrl-P Print (Playback mode only) 
Ctrl-S Save Configuration File 
Ctrl-R The Unfreeze button unfreezes all frozen items (blue text).   
Shift-F2 Set PC clock (Acquire mode only) 
Shift-F4 Set ADCP Clock (Acquire mode only) 
Shift-F6 Run Configuration Wizard 
Minus Previous Ensemble (Playback mode only) 
Space Next Ensemble (Playback mode only) 
Ctrl-Space Several Ensembles (Playback mode only) 
Home First Ensemble (Playback mode only) 
End Last Ensemble (Playback mode only) 
Z Zoom to data 
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2.4 User Options 
On the Settings menu, click User Options.  The User Options menu sets 
how WinRiver behaves in the Acquire and Playback modes.  

2.4.1 Acquire Mode Tab 

 
Upon Entering Acquire Mode 

• Prompt for Configuration File – If this option is selected you 
will be prompted to select a configuration file to load. 

• Start Pinging Immediately – Select this option if you want the 
ADCP to begin pinging as soon as the Acquire mode is started.   

• Start Recording Immediately – Select this option if you want 
the ADCP to begin recording as soon as the Acquire mode is 
started. 

Upon Exiting Acquire Mode 

• Confirm Exit if Recording – If this option is selected you will 
be prompted to confirm exiting the Acquire mode if recording.  
This helps prevent accidentally exiting during a transect. 

Terminal Program Path 

• Enter the path to your terminal program (normally DumbTerm).  
Use the Browse button to enter the path.  This will allow you to 
call the terminal program in the Acquire mode.  This can be 
useful if you want to test the ADCP or perform the compass 
calibration.   



 WinRiver User's Guide 

P/N 957-6171-00 (June 2001) page 7 

2.4.2 Display Tab 

 
• X Axis Contour Plots/Time Series Type – Select if the X-Axis 

on Contour Plots and Time Series will use Ensemble Number, 
Elapsed Time, or Length (distance traveled during the transect).   

• Number of Ensembles to Average – Averaging applies to dis-
plays and ASCII Out data only. 

• Display Only Averaged Ensembles – Check this box to display 
only the averaged ensembles.   

• Maximum Number of Ensembles on Plots – This limits the 
number of ensembles displayed on contour and time series plots. 
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2.4.3 General Tab 

 
Workspace Files 

• Load Last Workspace On Startup – Select this option if you 
want the same plots and displays opened as soon as the Acquire 
or Playback mode is started.  WinRiver saves separate setting for 
both modes in the *.wrw file.   

• Auto Save Workspace On Close – Select this option if you 
want to automatically save any changes to the workspace when-
ever WinRiver is exited or you switch modes. 

Configuration Files 

• Load Last Configuration On Startup - Select this option if you 
want the last configuration file to be loaded as soon as WinRiver 
is started. 

• Auto Save Configuration On Close - Select this option if you 
want to automatically save any changes to the configuration file 
whenever a new configuration file is loaded or WinRiver is 
exited. 
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2.4.4 Expert Tab 

 
• Velocity Display – Select Transform to Earth Coordinates to 

view velocity data in Earth coordinates (default setting).  To 
view the velocity data in the coordinate system the data was col-
lected in, select As Received From ADCP.  

 
NOTE.  If As Received From ADCP is selected, it will be set back to 
Transform to Earth Coordinates (default) when the WinRiver is exited. 
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3 File Naming Convention 
There are several files associated with WinRiver software.  These files are: 

• Data Files (*r.NNN) – These files contain all data sent from the 
ADCP and other devices during data collection.  Refer to the 
ADCP Technical Manual for a complete description of the for-
mat of raw ADCP data files.  For any specific deployment, raw 
data files contain the most information and are usually the larg-
est.  Data for this file type is collected through WinRiver’s Ac-
quire mode.  WinRiver’s Playback mode accepts raw ADCP data 
files for display or reprocessing. 

• Configuration Files (*.wrc, *w.000, *w.001) – These ASCII files 
contain user-specified setup and deployment information.  This 
file shares information between the different WinRiver modes.  
You can create different configuration files to suit specific appli-
cations through the Settings menu, Configuration Settings.   

 

NOTE. In the Settings menu, User Options, General tab you can specify 
if the last configuration file opens on startup and/or auto save the 
configuration file on close of the application. Configuration files can be 
loaded/saved through the File menu.   

 

• Workspace Files (*.wrw) – Binary file that contains information 
about open views, their size, and position.  Contains workspace 
information about Acquire and Playback modes.  Normally, Ac-
quire will have different window selections and sizes than the 
Playback mode.   

 

NOTE. In the Settings menu, User Options, General tab you can specify 
if the last workspace opens on startup and/or auto save the workspace on 
close of the application.  Workspace files can be loaded/saved through the 
File menu. 

 

• Navigation Files (*n.NNN) – These files contain ASCII data col-
lected from an external navigation device during data acquisi-
tion. WinRiver reads the navigation data from a user-specified 
serial port.   

• Depth Sounder Files (*d.NNN) – These files contain ASCII data 
collected from an external Depth Sounder device during data ac-
quisition. WinRiver reads the depth data from a user-specified se-
rial port.   

• External Heading Files (*h.NNN) – These files contain ASCII 
data collected from an External Heading device during data ac-
quisition. WinRiver reads the external heading data from a user-
specified serial port.   
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• ASCII-Out Files (*t.NNN) – These files contain a fixed format of 
ASCII text that you can create during post-processing.  During 
playback, you can subsection, average, scale, and process data.  
You also can write this data to an ASCII file.  You can then use 
these files in other programs (spreadsheets, databases, and word 
processors).   

• Processed Data File (*p.NNN) – Processed Data files are used 
for backward compatibility with the DOS based TRANSECT 
program.   

• Summary Files (*.sum) – These files contain ASCII information 
about the whole transect.  The information is written at the end 
of the file or subsection. 

3.1 Data Files 
File Name Format: ddddMMMx.NNN 
dddd Filename prefix (set in Settings menu, Configuration Set-

tings, Recording tab) 

MMM TRANSECT number.  This number starts at 000 and increments 
each time you stop and then start data collection.  The maxi-
mum number of transects is 999. 

x File type (assigned during data collection or playback) 

r – Raw ADCP data 
w – copy of the configuration file created during Acquire mode 
c – Unique configuration file (DOS TRANSECT only) 
h – External heading data 
n – Navigation GPS data 
d – Depth Sounder data 
p – Processed data 
t – ASCII-out data (This convention is the default for ASCII-
out data, but you can use other names and extensions.) 

NNN File sequence number.  This number starts at 000 and incre-
ments when the file size reaches the user-specified limit (set in 
Settings menu, Configuration Settings, Recording tab). 

Examples: 

NOAA001r.000 (Deployment name = NOAA, ADCP data file, tran-
sect number = 001, file number = 000) 

SN11005w.000 (Deployment name = SN11, configuration data file, 
transect number = 005, file number = 000) 
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3.2 Configuration Data Files 
File Name Format (*.wrc, *w.000, or *w.001) 

Extension Description 

*.wrc Original configuration file used to collect data. 

*w.000 Copy of the *.wrc configuration file created when the transect is 
completed (recording stopped) that saves the Setting menu, 
Configuration Settings items.   

*w.001 This file contains the changes (if any) made to the *w.000 file. 
 

The *w.000 Configuration Data File is a copy of the *wrc configuration file 
used to collect data.  The Playback mode will automatically load the *w.000 
configuration file that was created while acquiring the data and the *w.001 
file if it exists.  Any editing changes made to the *w.000 file are saved to 
the *w.001 file.  If a *c.000 (DOS TRANSECT unique configuration file) 
exists, it will be used and saved as a *w.001 file.  The *c.000 file will not be 
modified – any editing changes are saved to the *w.001 file. 

All items except the Chart Properties 1 and 2 tabs in the Setting menu, 
Configuration Settings will be grayed out in the Playback mode meaning 
that the values are used from the *w.000 configuration file.  Once the data 
file has been loaded changes can be made to the configuration file by right-
clicking the item.  Select between the following choices. 

Right-Click Option Description 

Use *w.000 value Returns the item to the value as data was collected. 

Open for Edit Changes the value for the current *w.001 file only.  Editing 
changes are saved to the *w.001 file. 

Open for Edit and 
Freeze 

Changes the value for the current *w.001 file and will stay in 
effect for each data file used in the Playback mode.  Use this 
mode if the same correction is needed for playing back 
subsequent transects.  For example, if the ADCP depth was 
incorrectly set for all transects, after loading the first data file, 
change the ADCP depth by right-clicking the ADCP Depth 
on the Settings menu, Configuration Settings, Offsets tab 
and select Edit and Freeze.  Enter the correct value.  When 
the next data file is opened, the correct ADCP depth value 
will be in effect. 
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3.3 Navigation Data Files 
Navigation Data Files are ASCII files created during Acquire. These files 
are not used to playback data. 

File Name Format (ddddMMMn.NNN) 

dddd = File prefix 

MMM = Transect number 

n = File type (Navigation) 

NNN = File sequence number 
 

The external device sending the navigation data determines the format of 
the navigation data file.  The navigation device can be any external device 
linked to WinRiver by a serial communication port.   
The navigation data should be ASCII, with a carriage return and line feed 
(CR/LF) generated after each data transmission. WinRiver receives the data 
from the navigation device and writes it to the navigation file.  Every time 
an ADCP ensemble is received, WinRiver also writes the ensemble number 
and the computer time to the navigation file.  Here is a sample navigation 
data format and program sequence. 

a. Navigation device sends data to the serial port.  For example: 
$GPGGA,190140.00,3254.81979,N,11706.15751,W,2,6,001.3,00213.4,M,-
032.8,M,005,0262*6F 
$GPGSA,M,3,1,14,22,16,,,18,19,,,,,3.5,1.3,3.3*08 
$GPVTG,108.0,T,,,000.3,N,000.6,K*21 
 

b. WinRiver writes this information to the ASCII (*n.000) navigation data 
file and to the *r.000 raw data file (see “Bottom Track Output Data 
Format,” page 82 and “Navigation Data Output Data Format,” page 90).  
WinRiver only uses the data in the *r.000 file.  

c. WinRiver receives an ensemble of data from the ADCP and writes the 
ensemble number and computer time to the navigation data file in the 
following format: 

<CR/LF>$RDENS,nnnnn,ssssss,PC<CR/LF> 
 

where:  

nnnnn = sequential ensemble number 

ssssss = computer time in hundredths of seconds 
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3.4 Depth Sounder Data Files 
Created during Acquire. These files are not used to playback data. 

File Name Format (ddddMMMd.NNN) 

dddd = File prefix 

MMM = Transect number 

d = File type (Depth Sounder) 

NNN = File sequence number 
 

The external device sending the depth data determines the format of the 
depth sounder data file.  The depth sounder device can be any external de-
vice linked to WinRiver by a serial communication port.   

The depth sounder data should be ASCII, with a carriage return and line 
feed (CR/LF) generated after each data transmission.  WinRiver receives the 
data from the depth sounder device and writes it to the depth sounder data 
file.  Every time an ADCP ensemble is received, WinRiver also writes the 
ensemble number and the computer time to the depth sounder data file.  
Here is a sample depth sounder data format and program sequence. 

a. Depth sounder device sends data to the serial port.  For example: 
$SDDBT,0084.5,f,0025.7,M,013.8,F 
 

b. WinRiver writes this information to the ASCII (*d.000) depth sounder 
data file and to the *r.000 raw data file (see “Bottom Track Output Data 
Format,” page 82 and “Navigation Data Output Data Format,” page 90).  
WinRiver only uses the data in the *r.000 file. 

c. WinRiver receives an ensemble of data from the ADCP and writes the 
ensemble number and computer time to the depth sounder data file in 
the following format: 

<CR/LF>$RDENS,nnnnn,ssssss,PC<CR/LF> 
 

where:  

nnnnn = sequential ensemble number 

ssssss = computer time in hundredths of seconds 
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3.5 External Heading Data Files 
Created during Acquire. These files are not used to playback data. 

File Name Format (ddddMMMh.NNN) 

dddd = File prefix 

MMM = Transect number 

h = File type (External Heading) 

NNN = File sequence number 
 

The external heading device sending the heading data determines the format 
of the data file.  The external heading device can be any external device 
linked to WinRiver by a serial communication port.   

The external heading data should be ASCII, with a carriage return and line 
feed (CR/LF) generated after each data transmission.  WinRiver receives the 
data from the external heading device and writes it to the external heading 
data file.  Every time an ADCP ensemble is received, WinRiver also writes 
the ensemble number and the computer time to the external heading data 
file.  Here is a sample external heading data format and program sequence. 

a. The external heading device sends data to the serial port.  For example: 
$INHDT,245.8,T*2E 
 

b. WinRiver writes this information to the ASCII (*h.000) external heading 
data file and to the *r.000 raw data file (see “Navigation Data Output 
Data Format,” page 90).  WinRiver only uses the data in the *r.000 file. 

c. WinRiver receives an ensemble of data from the ADCP and writes the 
ensemble number and computer time to the external heading data file in 
the following format: 

<CR/LF>$RDENS,nnnnn,ssssss,PC<CR/LF> 
 

where:  

nnnnn = sequential ensemble number 

ssssss = computer time in hundredths of seconds 
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3.6 ASCII-Out Files 
ASCII-out files contain a fixed format of text that you can create during 
post-processing by using the File menu, Start ASCII Out during Playback 
mode.  During playback, you can subsection, average, scale, and process 
data.  You also can write this data to an ASCII file.  You can then use these 
files in other programs (spreadsheets, databases, and word processors). 

The same control over data scaling, averaging, subsectioning, and process-
ing available during playback influences the ASCII-out file. WinRiver al-
ways writes velocity data (in earth coordinates) to the ASCII-out file.  For 
example, you may select only depth cells (bins) 4 through 9 for display on 
the screen, metric units (m, m/s), and use speed of sound corrections for a 
portion of data to be sent as ASCII-out.  WinRiver will scale, display, and 
write the velocity data to the ASCII-out file based on your processing speci-
fications.   

 

NOTE.  The profile data will include bins with the depth in between the 
minimum and maximum depth specified in Configuration Settings, Chart 
Properties 1 tab, Depth. 

 

Example ASCII-Out File 
This is WinRiver comment line #1 
This is WinRiver comment line #2 
    50     25     91     50      1     16      1  
0 3 27 8 18 37 26    29      1   -2.860    1.870  248.030   14.500  
-0.27     0.18     0.05     0.04     0.00    15.16     0.00    11.08    31.32    25.80    28.85    
30.04  
2.04         7.30         1.16        -0.98         1.52 
31.0098587   -91.6261329    -0.08     0.37          2.0 
94.5          40.2          16.6        1299.2          50.0           0.0           0.0  6.54  22.95 
15 ft BT dB 0.43  0.161 
  6.54      4.20    225.21   -3.0   -3.0   -0.7    1.2   72.5   73.0   73.0   74.7  100      -3.87 
  8.18      3.05    237.19   -2.6   -1.7   -0.3    0.3   80.3   82.5   81.2   82.0  100      -2.63 
  9.82      3.94    236.55   -3.3   -2.2   -0.2    1.0   81.6   87.6   83.3   82.0  100      -3.41 
 11.46      3.91    245.09   -3.5   -1.6   -0.4   -0.1   83.6   87.5   84.9   83.2  100      -3.13 
 13.11      4.55    242.24   -4.0   -2.1   -0.3    0.9   83.6   86.6   85.8   82.7  100      -3.76 
 14.75      1.94    224.59   -1.4   -1.4    0.0    0.8   88.5   92.4   85.1   82.9  100      -1.79 
 16.39      3.84    175.29    0.3   -3.8    0.5    1.6   89.8   94.1   85.5   85.1  100      -2.84 
 18.03      2.89    258.70   -2.8   -0.6   -0.3   -0.1   85.8   86.7   86.7   85.0  100      -1.91 
 19.67      4.54    223.45   -3.1   -3.3    0.1    1.4   85.2   86.5   89.1   86.5  100      -4.20 
 21.31      3.66    239.28   -3.2   -1.9   -0.2    0.2   86.2   92.2   91.8   89.6  100      -3.10 
 22.95      2.08    228.31   -1.6   -1.4    0.3   -0.3   87.1   96.1   92.3   89.7  100      -1.89 
 24.59    -32768    -32768 -32768 -32768 -32768 -32768   89.2   94.8   91.8   92.7    0 2147483647 
 26.23    -32768    -32768 -32768 -32768 -32768 -32768   88.3    255   93.5   93.1    0 2147483647 
 27.87    -32768    -32768 -32768 -32768 -32768 -32768   90.4    255  100.3   93.0    0 2147483647 
 29.51    -32768    -32768 -32768 -32768 -32768 -32768   94.6    255    255    255    0 2147483647 

 

3.7 Processed Data Files 
Processed Data (P-out) files can be created during post-processing by using 
the File menu, P-Out in the Playback mode.  During playback, you can 
subsection, average, scale, and process data.  You can then use processed 
data files with our DOS based TRANSECT program. 
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4 Quick Start Guide 
The Quick Start Guide has simple instructions for a typical discharge meas-
urement using the ADCP only (no GPS, External Heading or Depth 
Sounder). 

4.1 Setup the ADCP 
Step 1.  Connect the ADCP and computer as shown in your ADCP User's 
Guide.  Mount the ADCP on the boat at the desired depth (see the Work-
Horse Installation Guide.  If you have not already installed the WinRiver 
and DumbTerm programs do so as outlined in “Software Installation,” page 
2.  Run DumbTerm to verify the ADCP is functioning properly (see the RDI 
Tools User's Guide 

Water level

ADCP

Transducer Depth

 
Use this area for notes. 
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4.2 Start WinRiver 

 
Step 2.  Start WinRiver in the Acquire mode.  If you are in the Playback 
mode, click File, Acquire Mode.   

Use this area for notes. 
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4.3 Setup Communications 

 
Step 3.  On the Settings menu, click Communications to specify the com-
munications port parameters with the ADCP.   

Use this area for notes. 
 

 

 

 

 

 

 

 

 
 

 

NOTE. If you want to change the Com Port selection, use the Remove 
button and then Add the port back in.  If you want to change the baud rate 
or other properties, click the Properties button. 

 

 

NOTE.  The Quick Start Guide has simple instructions for a typical 
discharge measurement using the ADCP only (no GPS, External Heading, 
or Depth Sounder). For information on how to integrate GPS/External 
Heading/Depth Sounders, see “Integrating Depth Sounder, External 
Heading, and GPS Data,” page 57 
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4.4 Configuration Wizard 

 
Step 4.  The Configuration Wizard will create a configuration file and en-
ter the most important information needed for data collection and display 
during Acquire mode.   

On the Settings menu, click Configuration Wizard.  Enter your choices 
for Recording, Discharge, ADCP Configuration, Offsets, and Devices.  
Click the Run Wizard button.  If any error messages appear in the Con-
figuration Wizard Warnings box, correct the error and click the Run 
Wizard button again to verify the configuration file.  Click OK to save the 
configuration file or Save As to save the configuration file as a new file. 

Use this area for notes. 
 

 

 

 

 

 

 

 

 
 

 
NOTE. The configuration file names (*w.000 and *w.001) are keyed to the 
file name prefix. 
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4.5 WinRiver Workspace File 

 
Step 5.  A Workspace file contains the windows and arrangement of the 
windows that you are interested in.  To open a workspace file click File, 
Open Workspace File (you can customize WinRiver to automatically load 
the last used workspace file when the Acquire mode is started). 

To create a new Workspace file, set up the displays the way you prefer and 
then click File, Save Workspace File.  You will need to do this step for 
both Acquire and Playback modes.   
 

 
NOTE. Click File, New Workspace File to bring up the default workspace. 

 

Use this area for notes. 
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4.6 Perform Pre-Run 

 
Step 6.  On the File menu click Start Pinging (you can customize WinRiver 
to automatically start pinging when the Acquire mode is started). 

On the View menu, select Tabular Views, Discharge Standard Tabular if 
this window is not visible.  Move out from the shore until the water is deep 
enough to show Good Bins of two or greater.  Values of 0.0 are acceptable, 
but “bad” values are invalid.  Mentally note or mark this position with a 
float.  This is the starting/stopping position for this shore.  You will later 
start/stop data file recording at this location depending on the direction of 
your transect.  Move out from the shore traveling slowly with the bow of the 
boat pointed upstream.  When you approach the other shore, note or mark 
the closest distance to shore where two the top two depth cells show dis-
charge values.  This will be the start/stopping point for this shore.   

 

Use this area for notes. 
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4.7 Acquire Data – Near Shore 

DISTANCE TO SHORE

DISCHARGE VALUE IN TOP TWO DEPTH CELLS

 
Step 7.  Starting near the edge position determined during the pre-run, move 
out from the shore until the water is deep enough to show a discharge value 
in the top two depth cells.  This is the starting position for this transect.  
Press F5 to begin recording.   

When prompted, enter the beginning distance to the bank and define if this 
is the left or right bank.  The edge distance parameters will be saved to the 
configuration file (*w.000) associated with the raw ADCP data file re-
corded.   

 
NOTE. When facing downstream, the left bank is on your left side. 

 

Hold this position until 4 or 5 measurements are recorded.  If you made a 
false start, you can click F5 to stop recording and restart at the edge by 
clicking F5 to record to a new file.  The Left/Right bank toggles at the end 
of each transect, so click F5 once more to stop recording, and F5 again to 
start recording so the bank is back to the correct side.   

 

NOTE. The edge distance parameters can be changed during Playback 
mode if a mistake was made by selecting the Edge Estimates tab in the 
Settings, Configurations Settings menu and right-click the box. 

 

Use this area for notes. 
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4.8 Acquiring Data – River Transect 

 
Step 8.  Move across the river as slowly as possible.  For the best measure-
ment results, the boat’s speed over the bottom should be no greater than the 
water speed of the river.  Pointing the bow of the boat upstream and slowly 
crabbing across the river will help to maintain a transect path that is per-
pendicular to the flow.   

 

Use this area for notes. 
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4.9 Acquire Data – End Shore 

DISTANCE TO SHORE

D IS C H A R G E  VA LU E  IN  T O P  T W O  D E P T H  C E LL S

 
Step 9.  Continue across the river until you reach the edge position deter-
mined during the pre-run on the opposite shore.  You should have discharge 
values in only the top two depth cells.  Stop at this position and wait for 4 
or 5 measurements to be recorded.  Press F5 to stop recording.  When 
prompted, enter the ending distance to the bank.  That parameter will be 
saved to the configuration file (*w.000). 

 

Use this area for notes. 
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4.10 Acquire Data - Average 

 
Step 10.  Repeat steps 7 through 9 as many times as required for your appli-
cation.  An even number of at least four transects are recommended.  When 
you are finished acquiring the data, press F4 to stop the ADCP pinging.  
Turn off the power to the ADCP and disconnect the cable. Remember to 
replace the dummy plug to protect the connector. 

 

Use this area for notes. 
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4.11 Playback Data 
a. Start WinRiver in the Playback mode.  If you are in the Acquire mode, 

click File, Playback Mode.  

b. On the File menu click Open ADCP Raw Data File and select the file 
to be played.  WinRiver automatically creates a *w.001 configuration 
file. 

• If the *w.000 configuration file exists, all of the values in the Set-
tings menu, Configuration Settings tabs except the Chart Proper-
ties 1 and 2 tabs will be used.  The values will be grayed out.  No 
changes can be made unless the item is right-clicked.  Items that you 
decide to change during data playback will be saved in the *w.001 
configuration file.  The *w.000 files will not be changed.   

• If a *w.000 configuration file does not exist you can modify all of 
the items in the *w.001 configuration file.   

c. Create a new Workspace file by clicking File, New Workspace File.  To 
open a workspace file, click File, Open Workspace File. 

d. On the Playback menu, click Play to start playing the data.  To quickly 
process the data select Last Ensemble.  The playback tool bar has func-
tions to start, stop, rewind, and go to the end of the data file.   

e. To quickly see what files are in use look at the WinRiver Title Bar.  This 
lists the files in use. 

 
Figure 2. WinRiver Playback Mode Title Bar 

work.wrw = Workspace file in use 

DATAw.000 = Unique configuration file (created during data collection) 

data.wrc = Configuration file in use 

DATAr.000 = Raw ADCP data file in use 
 

Use this area for notes. 
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4.12 Compute Total Discharge 

 
Play back the individual data files with their associated configuration files 
in the Playback mode.  After playing through the data file, press View, 
Tabular Views, Discharge Tabular Views, Discharge History to obtain 
the total discharge for each measurement.   

As each data file is played in the Playback mode, the file is added to the 
Discharge History Tabular screen.  To remove a file from the table, dou-
ble-click the file name.  You will be prompted to clear only the selected file 
or the entire table.  The Discharge History Tabular display will automati-
cally calculate the average and other statistics useful in determining the dis-
charge value. 

 

Use this area for notes. 
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5 Creating a WinRiver Configuration File 
In the following, you will be creating a configuration file that will be used 
to program both the ADCP and WinRiver software processing. 

a. In the Acquire or Playback mode, click File, New Configuration File. 

b. To change configuration parameters click Settings, Configuration 
Settings.  

c. When creating a configuration file for Acquire mode the most important 
parts in a configuration file are the Commands and Recording tabs.  
Set them to the desired parameters.  The rest of the parameters can be 
changed during playback and do not influence data collection.   

d. For correct data display while acquiring data you can enter the following 
values.   

• On the Offsets tab set the ADCP Transducer Depth.   

• On the Discharge tab, specify if you have any preference how to 
calculate discharge and if you know the shape of your edge bank.   

• On the DS/GPS tab, select Depth Sounder to be used in process-
ing if you are using a depth sounder and you do not have valid bot-
tom track data.   

 
NOTE.  To easily set the configuration file parameters for data collection 
see “Using the Configuration Wizard,” page 30.   

 

e. When creating a configuration file for Playback mode, items will be 
read from the corresponding *w.000 file and *w.001 (if it exists) or 
*c.000 (DOS Transect configuration file) and will not be accessible in 
the Settings, Configuration Settings menu.  To modify an item, see 
“Configuration Data Files,” page 12.  

f. Once you have set the parameters save the configuration file by clicking 
File, Save Configuration File.  Click File, Save Configuration File As 
to save the configuration file under a unique name. 
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5.1 Using the Configuration Wizard 
The Configuration Wizard creates a configuration file and enters the most 
important information needed for data collection and correct data display 
during Acquire mode.   

 
NOTE.  The Configuration Wizard is not available in the Playback mode. 

 

 
Figure 3. Configuration Wizard 
a. On the Settings menu, click Configuration Wizard.   

b. Enter your choices for the Recording section.  The Filename Prefix 
and Output Directory are part of the Recording tab (see “Recording 
Tab,” page 41). 

c. Enter your choices for the Discharge section.  For more information on 
these settings, see the “Discharge Tab,” page 37. 

d. Enter your choices for the ADCP Configuration section.  Based on the 
entered information, the wizard will enter commands on the 
“Commands Tab,” page 43.   

e. Enter your choices for the Offsets section.  For more information on 
these settings, see the “Offsets Tab,” page 32. 
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f. Enter your choices for the Devices section.  Selecting any of the boxes 
will prompt you to set up the communication settings and the 
“DS/GPS/EH Tab,” page 39.   

g. Click the Run Wizard button.  If any error messages appear in the Con-
figuration Wizard Warnings box, correct the error and click the Run 
Wizard button again to verify the configuration file.   

h. Click OK to save the configuration file or Save As to save the configu-
ration file as a new file. 

i. To see the configuration file settings that the wizard entered, on the Set-
tings menu, click Configuration Settings (see “Configuration Set-
tings,” page 31).   

5.2 Configuration Settings 
This section has detailed explanations of each of the Setting menu, Con-
figuration Setting tabs needed to create a configuration file.  There are ten 
tabs that configure different portions of the configuration file. 

Offsets Tab Recording Tab 

Processing Tab Commands Tab 

Discharge Tab Chart Properties 1 Tab 

Edge Estimates Tab Chart Properties 2 Tab 

DS/GPS Tab Resets Tab 
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5.2.1 Offsets Tab 
The Offsets tab lets you set system alignment offsets that only affect the 
displays, not the raw data files.  WinRiver saves these settings in the con-
figuration file.  

 
Figure 4. Offsets Tab 
The functions of this submenu are: 

• ADCP Transducer Depth - Use the Transducer Depth field to 
set the depth from the water surface to the ADCP transducer 
faces.  WinRiver uses this value during data collection and post-
processing to create the vertical depth scales on all displays. 
WinRiver also uses the depth value to estimate the unmeasured 
discharge at the top part of the velocity profile.  Therefore, depth 
affects the estimate of total discharge on the data collection and 
post-processing displays.  The depth value does not affect raw 
data, so you can use different values during post-processing to 
refine the vertical plot scales and discharge estimates. 



 WinRiver User's Guide 

P/N 957-6171-00 (June 2001) page 33 

 

NOTE. The ADCP’s ED-command (Depth of Transducer) is used for 
internal ADCP speed of sound processing and is stored in the raw ADCP 
file leader.  The ED-command has no effect on the vertical depth scales in 
WinRiver. For normal transect work, do not add an ED-command. 

 

• Magnetic Variation – Use the Magnetic Variation field to ac-
count for magnetic variation (declination) at the deployment site.  
East magnetic declination values are positive.  West values are 
negative.  WinRiver uses magnetic variation in the data collec-
tion and Playback displays to correct ADCP velocities and bot-
tom-track velocities. 

 

NOTE. The ADCP’s EB-command (Heading Bias) and EX-command 
(Coordinate Transformation) process ADCP data before creating the raw 
data.  The Magnetic Variation field in WinRiver processes the raw data 
received from the ADCP for data display.  The magnetic variation field is 
not converted to an EB-command (raw data is not effected).  This allows 
you to use the Magnetic Variation field to make changes during post-
processing. For normal transect work, do not add an EB-command. 
The WinRiver compass corrections will only be applied to the profile data 
when the data was collected in Beam, Instrument, or Ship coordinates. 

 

• Beam 3 Misalignment – WinRiver uses the Beam 3 Misalign-
ment value to align the ADCP’s north reference (Beam 3) to the 
ships bow (see the WorkHorse Installation Guide). 

• Compass Correction – See “Compass Correction,” page 65, for 
details on how to do the compass correction. 
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5.2.2 Processing Tab 
The Processing tab lets you set several system processing options and save 
them to a configuration file.  Most values in the Processing tab affect the 
displays during data collection and post-processing.  WinRiver saves these 
values only to the configuration file, not to the raw data files.   

 
Figure 5. Processing Tab 
The functions of this submenu are: 
Speed of Sound 

The Speed Of Sound box lets you correct velocity data for speed of sound 
variations in water. WinRiver can make these corrections dynamically with 
every ping or use a fixed speed of sound value.  Use the Use ADCP Value 
option to select the value being used by the ADCP.  The EC and EZ-
commands determine the ADCP’s speed of sound value.  Choosing the Use 
ADCP Value tells WinRiver not to do any speed of sound scaling of veloc-
ity data after it is received from the ADCP.   
Selecting the Calculate For Each Ping option uses the Salinity Value, 
ADCP transducer depth, and the water temperature at the transducer head to 
compute speed of sound for each raw ADCP ensemble.  WinRiver then uses 
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this value to scale the ADCP velocity data dynamically.  WinRiver uses 
scaled velocity data in the displays and for discharge calculations. 

Use the Fixed option to set a fixed value for sound speed. Select this option 
if you made a mistake during data collection.  WinRiver uses the fixed value 
to re-scale the velocity data from the ADCP.   
Projection Angle 

This is the angle used to calculate the projected velocity that is displayed in 
the Projected Velocity contour plot. 
Backscatter 

The Backscatter options control the values used to convert between meas-
ured Receive Signal Strength (RSSI) to backscatter.  These parameters have 
no affect on discharge and only affect backscatter. 

The Near Zone Distance is the distance away from the transducer where 
the beam transitions from cylindrical to conical.  The angle of the cone is 
the beam width.  The default value should be used for 600 and 1200kHz Rio 
Grande.  Other transducers should use the formula shown in Figure 6. 

D 40 degrees

Near Zone Distance

= 1500/frequency
Near Zone Distance = D /2

 
Figure 6. Near Zone Distance 
WinRiver uses the Echo Intensity Scale (dB per RSSI count) value to con-
vert the ADCP signal strength (RSSI, AGC) from counts to dB before cor-
recting it for absorption and beam spreading beyond the Near Zone Dis-
tance.  Echo intensity in decibels (dB) is a measure of the signal strength of 
the returning echo from the scatterers.  It is a function of sound absorption, 
beam spreading, transmitted power, and the backscatter coefficient.  For 
more information on echo intensity, see RDI’s Principles of Operation: A 
Practical Primer.  The echo intensity scale is temperature dependent based 
on the following formula.  Echo intensity scale (dB per RSSI count) = 
127.3 / (Te + 273) where Te is the temperature (in °C) of the ADCP elec-
tronics and is calculated by WinRiver unless overridden by the user.  At am-
bient temperature, the nominal scale is 0.43dB per count.  Speed of Sound 
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is based on temperature and salinity and uses that value unless overridden 
by the user. 

The sound absorption coefficient, which is used to estimate echo intensity 
in decibels, is a function of frequency.  Beyond the Near Zone Distance, 
WinRiver range-normalizes echo intensity using the formula: 

I[dB] = (Echo Intensity Scale[dB/counts]) x I[counts] 
+ 20 x Log(R) [spreading ] 

+ 2 x (Sound absorption coefficient) x R [absorption] 

Where R = Distance from transducer to ADCP depth cell in meters. 
Cross Sectional Area 

Cross Sectional Area can be calculated using three different methods: as 
perpendicular to the mean flow, perpendicular to the projection angle, or 
parallel to the average course. 
Data Screening 

Select Mark Below Bottom Bad to mark data below the ADCP-detected 
bottom or Depth Sounder detected bottom (if selected for processing).  
Check the Use 3 Beam Solution for BT box to allows 3-beam solutions if 
one beam is below the correlation threshold set by the BC command.  
Check the Use 3 Beam Solution for WT box to allows 3-beam solutions if 
one beam is below the correlation threshold set by the WC command.   
Thresholds 

Bottom Track Error Velocity - The ADCP uses this parameter to deter-
mine good bottom-track velocity data.  If the ADCP’s error velocity value 
exceeds this threshold, it flags data as bad for a given depth cell.   

Water Track Error Velocity - The ADCP uses this parameter to set a 
threshold value used to flag water-current data as good or bad.  If the 
ADCP’s error velocity value exceeds this threshold, it flags data as bad for 
a given depth cell.   

Bottom Track Up Velocity - The ADCP uses this parameter to determine 
good bottom-track velocity data.  If the ADCP’s upward velocity value ex-
ceeds this threshold, it flags data as bad for a given depth cell.   

Water Track Up Velocity - The ADCP uses this parameter to set a thresh-
old value used to flag water-current data as good or bad.  If the ADCP’s 
upward velocity value exceeds this threshold, it flags data as bad for a given 
depth cell.   

Fish Intensity - The ADCP uses this parameter to screen water-track data 
for false targets (usually fish).  If the threshold value is exceeded, the 
ADCP rejects velocity data on a cell-by-cell basis for either the affected 
beam (fish detected in only one beam) or for the affected cell in all four 
beams (fish detected in more than one beam).   
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5.2.3 Discharge Tab 
WinRiver uses these setting to determine what formulas and calculations 
will be used to determine the discharge value. 

 
Figure 7. Discharge Tab 

• Parameters – There are two methods available in WinRiver to 
estimate discharge in the unmeasured top/bottom parts of the ve-
locity profile based on the Top/Bottom Discharge Method set-
tings.  The two methods are Constant and Power.  The Power 
Curve Coefficient can be changed if the Power Method is used.  
The default is set to 1/6.  The Power fit is always used to fill in 
“missing” data in the profile. For more details, see the WinRiver 
help file. 

• Cut Water Profiles Bins – You can select additional bins to be 
removed from the top or bottom measured discharge. 

• Shore – The Left/Right Bank Edge Type is used in estimating 
shore discharges.  You can select a predefined shape of the area 
as Triangular or Square, or set a coefficient that describes the 
shore.  Several pings can be averaged as determined by Shore 
Pings in order to estimate the depth and mean velocity of the 
shore discharge.  For more details, see the WinRiver help file. 
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5.2.4 Edge Estimates Tab 
This menu lets you estimate the near-shore discharge, that is, near the banks 
of a channel where the ADCP cannot collect data. These settings should ac-
count for the beginning and ending areas of the transect not measured by 
the ADCP.   

 
Figure 8. Edge Estimates Tab 
Begin Transect 

• Shore Distance – Enter the distance to the shore at the beginning 
of the transect. 

• Left/Right bank.  Define if the shore when you start the transect 
is the left or right bank.  When facing downstream, the left bank 
is on your left side. 

End Transect 

• Shore Distance – Enter the distance to the shore at the end of the 
transect. 



 WinRiver User's Guide 

P/N 957-6171-00 (June 2001) page 39 

5.2.5 DS/GPS/EH Tab 
The depth sounder is another external sensor that can be used to track the 
depth of the water.  Areas with weeds or high sediment concentrations may 
cause the ADCP to lose the bottom.  

 
Figure 9. DS/GPS Tab 
Depth Sounder 

• Use in Processing – This will instruct WinRiver to use the depth 
sounder value in the discharge calculation rather then the ADCP 
beam depths.  

• Transducer Depth – Use the Transducer Depth to set the depth 
from the surface of the water to the Depth Sounder transducer 
face. 

• Offset – In addition to the Transducer Depth, you can also add 
an additional offset to reconcile any differences between the 
ADCP bottom track depths and those reported by the DBT 
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NMEA string.  Entering a value in the Offset box enables this 
additional offset. 

• Scale Factor – Many depth sounders only allow a fixed value of 
1500 m/s for sound speed.  You can apply a scaling factor to the 
raw NMEA depth sounder output by entering a number in place 
of the Correct Speed Of Sound command.  Note that the depths 
reported by the DBT NMEA string do not include the depth of 
the sounder, so the scaling is applied to the range reported from 
the depth sounder to the bottom.  

• Correct Speed Of Sound – WinRiver can scale the depth 
sounder depths by the sound speed used by WinRiver by select-
ing the Correct Speed Of Sound box.    

GPS 

• Time Delay – If desired, you can allow for a lead-time between 
the GPS position updates and the ADCP data.  Inserting a value 
in the Time Delay box does this.  If you enter a value of 1, the 
lead is set for 1 second.  This assumes GPS data is one second 
old compared to the ADCP.   

 
NOTE. The recommended value is zero. 

 

External Heading 

Use the Heading Offset field to reconcile any differences between the 
ADCP bottom track heading and those reported by the External Heading 
NMEA string.  Entering a value in the Offset box enables this additional 
offset. 
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5.2.6 Recording Tab 
The Recording tab lists the parameters used to define where the data is re-
corded during data collection.   

 
Figure 10. Recording Tab 

• Filename Prefix – WinRiver uses the Filename Prefix to create 
the data file names made during data collection.  Use the Output 
Directory field to select where the data file will be stored.   

During data collection, if the Filename Prefix is set to TEST, 
WinRiver creates data files with the prefix TEST 
(TEST####.###) and stores them in the directory specified in the 
Output Directory field until the disk is full.  WinRiver will then 
stop data collection and alert you to the disk space problem. 

 

NOTE.  A file name can contain up to 255 characters, including spaces 
and the Filename Prefix. It cannot contain the following characters: \ / : * ? 
" < > | 
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• Maximum File Size – Use the Maximum File Size field to limit 
the size of a data file.  The default for the maximum data file 
size is unlimited.  If you set the Maximum File Size to 1.44, then 
when the size of the recorded data file reaches 1.44 MB, the file 
name extension increments.  

• Next Transect Number – The program will start with the num-
ber specified in the Next Transect Number box.  If the transect 
already exists, the next number available will be used. 

• If you want to record ASCII External Heading, GPS, and Depth 
Sounder data, select the appropriate box.   

 
NOTE. If you want to use the depth sounder data in place of the ADCP 
depth, then you must select Use in Processing on the DS/GPS tab. 

 

 

NOTE. If you use External Heading, GPS, or Depth Sounder devices 
during data collection the data will always be written to the raw ADCP data 
file.  Collecting ASCII External Heading, GPS, or Depth Sounder files is not 
required and are not used by WinRiver. 

 

• Comment #1, #2 – Use these two lines for your notes.   
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5.2.7 Commands Tab 
You can directly control the profiling parameters sent to the ADCP using 
the User Commands box.  The ADCP Technical Manual explains all direct 
commands in detail.  The Fixed Commands box lets you view the direct 
commands that will always be sent to the ADCP.  The Configuration Wiz-
ard will enter the Wizard Commands based on information entered in the 
Configuration Wizard (see “Using the Configuration Wizard,” page 30). 

 

CAUTION.  The fixed commands are sent before any user commands.  
Sending a User Command will OVERRIDE the Fixed and Wizard 
Commands.   

 

When the Acquire mode is first started, the commands in the Fixed Com-
mands box are sent by WinRiver to the ADCP to set its profiling parame-
ters.  The Wizard Commands are sent next and will override some of the 
Fixed Commands.  In the following, we will describe each command and 
give guidelines for setting these commands for acquiring reliable discharge 
data.  Refer to the ADCP Technical Manual for more detailed information 
about each command. 

 
Figure 11. Commands Tab 
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Table  2: Fixed Commands 
Command Choices Description 

CR1 Sets factory defaults This is the first command sent to the ADCP to place it in a "known" 
state. 

CF11110 Flow control CF11110 selects automatic ensemble cycling, automatic ping cycling, 
binary data output, enables serial output, and disables data recording. 

BA30 Evaluation Amplitude 
Minimum 

Sets the minimum value for valid bottom detection to 30 counts. 

BC220 Correlation Magnitude 
Minimum 

Sets minimum correlation magnitude for valid bottom track velocity data 
to 220 counts. 

BE100 Bottom Track Error 
Velocity Maximum 

Sets maximum error velocity for good bottom-track water-current data 
to 100mm/s. 

BP1 Bottom track pings The ADCP will ping 1 bottom track ping per ensemble. 

ES0 Salinity Salinity of water is set to 0 (freshwater). 

EX10111 Coordinate 
transformations 

Sets Ship coordinates, use tilts, allow three-beam solutions, and allow 
bin mapping to ON. 

TE00:00:00.00 Time per ensemble Ensemble interval is set to zero. 

TP00:00.20 Time between pings Sets the time between pings to 0.2 seconds. 

WA50 False Target Threshold 
Maximum 

Sets a false target (fish) filter to 50 counts. 

WE1500 Water Track Error 
Velocity Threshold 

Sets the maximum error velocity for good water-current data to 
1500mm/s. 

WF50 Blank after transmit Moves the location of the first depth cell 50 cm away from the 
transducer head (see Table 3). 

WM1 Water mode Sets the ADCP to Water Track mode 1. 

WN50 Number of depth cells Number of bins is set to 50 (see Table 3). 

WP1 Pings per ensemble The ADCP will ping 1 water track ping per ensemble. 

WS50 Depth cell size Bin size is set to 0.5 meters (see Table 3). 

WV170 Ambiguity velocity Sets the maximum relative radial velocity between water-current speed 
and Workhorse speed to 170 cm/s. 

WZ005 Mode 5 Ambiguity 
Velocity 

Sets the minimum radial ambiguity for profiling Mode 5 (WM5) and 
Mode 8 (WM8) Ambiguity Velocity to 5 cm/s. 

&R20 Bottom Illumination The &R command is used to set the "Bottom Illumination". This value 
determines the size of the Bottom Track transmit pulse in relation to the 
Depth.  &R is entered in percent.  If you were bottom tracking in 100m 
of water and had &R=20, the Bottom Track transmit pulse would be 
20% of 100m, or 20m.  If &R=30, then the transmit pulse would be 
30m.  

 

Table  3: Wizard Commands 
Command Choices Description 

BXxxx Maximum Bottom 
Search 

Limits how far the ADCP will search for the bottom 

WFxx Blank after transmit Moves the location of the first depth cell away from the transducer 
head. 

WMx Water Mode Sets the Water Mode 

WNxxx Depth cell number 

WSxxx Depth cell size 

Based on the maximum water depth entered in the Configuration 
Wizard, WinRiver will set the depth cell size and number of depth 
cells.  

WVxxx Ambiguity velocity Sets the maximum relative radial velocity between water-current 
speed and Workhorse speed. 

TPxx:xx.xx Time between pings Sets the time between pings. 

 

 

NOTE.  The values for the Wizard Commands are based on information 
entered in the Configuration Wizard (see “Using the Configuration 
Wizard,” page 30). 
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5.2.8 Chart Properties 1 Tab 
The Chart Properties 1 tab lets you select display and scaling options for 
all graphics screens in real-time.  By selecting the appropriate minimum and 
maximum values for the displays, specific features in the data become more 
visible.  WinRiver saves all scaling information to the configuration file.   

 
NOTE. To quickly access the graph scales right-click on the graph and 
select Properties.   

 
Figure 12. Chart Properties 1 Tab 
Scalable parameters include the following. 
East Velocity (in m/s or ft/s) Velocity Magnitude (in m/s or ft/s) Intensity (in counts) 

North Velocity (in m/s or 
ft/s) 

Velocity Direction (in degrees) Backscatter (in dB) 

Up Velocity (in m/s or ft/s) Projected Velocity (in m/s or ft/s) Correlation (in counts) 

Error Velocity (in m/s or 
ft/s) 

Depth (in m or ft) Discharge 

 

 

NOTE. If the Auto Save Configuration file mode is on (see Users Option 
menu) the chart properties will be re-saved to the *w.001 file.  The file will 
play back with the same chart properties the next time the file is opened. 
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5.2.9 Chart Properties 2 Tab 
The Chart Properties 2 tab lets you select display and scaling options for 
all graphics screens in real-time.  By selecting appropriate the mini-
mum/maximum values for the displays, specific features in the data become 
more visible.  WinRiver saves all scaling information to the configuration 
file.   

 
NOTE. To quickly access the graph scales right-click on the graph and 
select Properties.   

 

 
Figure 13. Chart Properties 2 Tab 
Scalable parameters include the following. 

East Displacement (in m or ft) Pitch, Roll (in degrees) 

North Displacement (in m or ft) Water Speed (in m/s or ft/s) 

Heading (in degrees) Boat Speed (in m/s or ft/s) 
 

 

NOTE. If the Auto Save Configuration file mode is on (see Users Option 
menu) the chart properties will be re-saved to the *w.001 file.  The file will 
play back with the same chart properties the next time the file is opened. 
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5.2.10 Resets Tab 
The Unfreeze (Ctrl-R) button resets the configuration controls to unfreeze 
all frozen parameters.  This allows the next *w.000 and *w.001 files to have 
complete control.  This is the same as exiting WinRiver and restarting the 
program. 

If you want to reset the configuration parameters back to the *w.000 values, 
use the Reset to *w.000 button.   

 
Figure 14. Resets Tab 
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6 Acquiring Discharge Data 
Starting WinRiver in the Acquire mode loads the direct commands from the 
configuration file to the ADCP and controls data recording for acquisitions 
of individual transect discharge data.  Data can be displayed in tabular, 
ship’s track, profile, or contour formats.  WinRiver calculates discharge as it 
is calculated in real-time and accumulated as a transect is made across the 
river.  

 

NOTE.  It is a good idea to run DumbTerm before collecting data at a 
particular site to check the ADCP’s operation. DumbTerm runs a series of 
tests and creates a log file that records the results of the tests that are 
performed.   

 

a. Start WinRiver in the Acquire mode.  If you are in the Playback mode, 
click File, Acquire Mode.   

b. You may want to record a note about the instrument setup or factors 
such as wind conditions, the passage of other vessels, and any other 
noteworthy events that occur during your transect of the channel.  Use 
the Settings menu, Configuration Setting, Recording tab to add a 
comment to the configuration file.  

 
NOTE. The note will be saved to the configuration file (a *w.000 file is 
created for every transect), not with the data file.  

 

c. Press F4 to start the ADCP pinging.  The Acquire Tabular window will 
now show ADCP PINGING.   

 In a few seconds, you will see changing values in several of the data 
windows.  The ensemble number will update, the time displayed just be-
low the ensemble number will change to show the ADCP time of each 
ensemble, the position sensors will update, and so on.  And, if you have 
the ADCP in sufficiently deep water, you will see velocity profiles on 
the graph.  WinRiver will not display meaningful data if your system is 
not in water.  

 In general, after you have started the ADCP pinging, there is no reason 
to stop pinging until you are finished and ready to remove the ADCP 
from the water.  An exception would be if you were operating off of bat-
teries with limited capacity.  Then stopping pinging will conserve 
power.   

 

NOTE.  You can let the ADCP ping even if it is not in the water.  Unlike 
many other acoustic devices, no damage to the ADCP will occur.  It is often 
useful to operate the ADCP out of the water to test configuration files, 
practice with WinRiver, or perform other tests. 
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d. Before going forward, on the Settings menu, click Reference.  Choose 
Bottom Track from the list.  This will ensure that the velocity reference 
for the data display is set to bottom track. When bottom track is used as 
the velocity reference, the speed of the ADCP over ground is subtracted 
from the measured relative velocity to give true Earth referenced water 
velocity. You can always determine what velocity reference is in use by 
looking at the text lines just above and below the scales at the top and 
bottom of the graph display.  At the end of each line is an indication of 
the reference being used.  

6.1 Performing a Pre-Run 
It is a good idea to perform a pre-run transect before actually acquiring 
data. This gives you the opportunity to ensure that the ADCP is working as 
expected with the loaded configuration file.  You will also determine the 
starting/stopping locations at each side of the channel.  As you cross, you 
can monitor the depth to see if there are areas with abrupt depth changes. 
Later, during data acquisition, you will want to cross very slowly over these 
regions to help bottom tracking maintain a valid lock on the bottom. 

a. On the View menu, select the Tabular, Discharge Standard Tabular 
(see Figure 15) if you are not already viewing this plot.  When making 
an individual discharge measurement, you want to start and stop the re-
cording of data in water sufficiently deep to allow valid data to be re-
corded.  Use the tabular display to determine when the water is deep 
enough to give a discharge value in the top two depth cells (Good Bins 
= 2 or more).  You will be using a power fit for the extrapolation of the 
top and bottom, and at least two depth cells with valid discharge are 
needed in order to compute a more accurate power fit.  

 
Figure 15. Discharge Standard Tabular Display 
b. Move out from the shore until the water is deep enough to show a dis-

charge value in the top two depth cells. Mentally note or mark this posi-
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tion with a float.  This is the starting/stopping position for this shore.  
You will later start/stop data file recording at this location depending on 
the direction of your transect.   

c. Move out from the shore traveling slowly with the bow of the boat 
pointed upstream.  On the View menu, select Contour Plots, Velocity, 
Velocity Magnitude Contour.  The display will look similar to that 
shown in Figure 16.  Use this display to see how the water depth 
changes as you make your transect.  Note regions where the bottom 
depth changes quickly. 

 
Figure 16. Velocity Magnitude Contour Plot 
d. As you approach the other shore, change the display back to tabular, and 

note or mark the closest distance to shore where two the top two depth 
cells show discharge values.  This will be the start/stopping point for 
this shore.   

6.2 Holding Position at the Starting Channel Edge 
a. Starting at one of your marked edges, use the Discharge Standard 

Tabular display to ensure that you have at least two valid discharge 
measurements.   

b. While holding position at the location where you have two valid cells of 
data, determine the edge distance to shore, and then press F5 to start 
data recording.  You will be prompted for a starting distance to shore.  A 
unique configuration file, *w.000, will be created and saved in the same 
directory as the raw data file.  This configuration file will contain the 
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starting edge distance as well as the ending edge distance you will enter 
later at the end of the transect. 

 
NOTE. Data processing continues while WinRiver is prompting for the 
edge distance. 

 

c. Holding position for 4 to 5 ensembles after beginning the recording of 
data, enter the value for the starting shore distance.  The extra ensembles 
that are recorded to the raw data file during this stationary period will 
help to ensure that you have a good starting ensemble for estimation of 
the side discharge.  This must be enabled on the Settings menu, Con-
figuration Settings, Discharge tab, Shore Pings box. 

6.3 Crossing the Channel 
a. Once several ensembles are recorded at the edge, slowly move away 

from the shore.  Head for the desired ending point on the other side of 
the channel.  Avoid fast accelerations, and keep the transect speed at or 
less than the water speed.  Since you will be crossing slowly, you will be 
forced to point the bow nearly upriver and crab across.  The slower you 
cross, the better your results will be. 

b. As you make your transect, take some time to experiment with the dif-
ferent display options.  The display scales can be changed on the Chart 
Properties 1 and 2 tabs or right-click on a plot and select Properties. 

c. You can see the discharge for the top, middle and bottom layers on the 
Discharge Tabular screen.   

6.4 Holding Position at the Ending Channel Edge 
Continue across the river until you reach the edge position determined dur-
ing the pre-run on the opposite shore.  You should have discharge values in 
at least the top two depth cells.  Stop at this position and wait for 4 or 5 
measurements to be recorded.  Press F5 to stop recording data.  You will be 
prompted to enter the ending edge distance.  Enter the value of the distance 
to shore. 

6.5 Acquiring Discharge Data for Multiple Transects 
Congratulations, you have just completed your first discharge measurement.  
You can now repeat the discharge measurement procedure to make addi-
tional transects.  You will typically use F5 to start and stop recording data 
for each passage across the channel while letting the ADCP ping continu-
ously.  An even number of transects is recommended, and the discharge 
from each individual transect can be averaged together to provide a dis-
charge measurement for the site with lower variance than that of a single 
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transect (see “Compute Total Discharge,” page 28).  A new data and con-
figuration file will be created each time you start and stop recording, and 
the starting and ending edge distances along with any entered notes will be 
saved in the unique configuration file. 

When you have finished your desired number of transects and you are ready 
to stop data collection, press F4 to stop pinging.   

7 Post-Processing of Discharge Data 
The Playback mode of WinRiver is used for post-processing data to get a 
total discharge value for the channel.  Within the Playback mode, you can 
subsection the data to remove bad ensembles or create ASCII data files to 
use in other programs.   

Modifying the WinRiver configuration file in the Setting, Configuration 
Settings tabs allows you to re-scale the raw data file to correct for variables 
that may have been incorrectly set during data collection such as the trans-
ducer depth, the salinity value, or the edge distances.   

7.1 Loading a Data File 
a. Start WinRiver in the Playback mode.  If you are in the Acquire mode, 

click File, Playback Mode.  

b. On the File menu click Open ADCP Raw Data File and select the file 
to be played.  WinRiver automatically creates a *w.001 configuration 
file. 

• If the *w.000 configuration file exists, all of the values in the 
Settings menu, Configuration Settings tabs except the Chart 
Properties 1 and 2 tabs will be used.  The values will be grayed 
out.  No changes can be made unless the item is right-clicked.  
Items that you decide to change during data playback will be 
saved in the *w.001 configuration file.  The *w.000 files will not 
be changed.   

• If a *w.000 configuration file does not exist you can modify all 
of the items in the *w.001 configuration file.   

c. Create a new Workspace file by clicking File, New Workspace File.  To 
open a workspace file, click File, Open Workspace File.  

d. On the Playback menu, click Play to start playing the data.  To quickly 
process the data select Last Ensemble.  The playback tool bar has func-
tions to start, stop, rewind, and go to the end of the data file. 
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7.2 Viewing Discharge Data 
The Playback data display options are the same as those for the Acquire 
mode.  Take some time to experiment with the formats, and refer to the 
WinRiver help file for more details on the Playback menu and available 
displays. 

a. WinRiver can single-step through the data or run through at maximum 
speed.  You can toggle between the pause/resume states by pressing F4.  
When the pause-state is enabled, SPACEBAR-STEP is displayed in the Status 
Bar.  Press the space bar to single step through each ensemble of data.  
When the data file is played through to the end, press Home to rewind it 
to the beginning.  Press End to play the data file to the end.   

b. On the Setting, Reference menu, choose Bottom Track as the velocity 
reference.  You will want to use this reference for data display and the 
calculation of discharge.  In this reference, the boat’s velocities are sub-
tracted from the measured velocities to present true water velocities.   

c. Use the Setting menu, Configuration Setting, Chart Properties 1 and 
2 tabs or right-click the display and select Properties to change the scal-
ing fields of the different data displays.   

d. Press Z to zoom in on the Ship Track and Stick Ship Track plots, and 
then End to play back the data file completely.   

7.3 Editing an Item During Playback 
Most of the parameters in the Configuration Settings can be changed while 
playing back data.  Only the parameters that control data collection (Re-
cording and Commands tab) does not change the way data is reprocessed.   

Example – The Shore Distance for the Begin Transect was incorrectly en-
tered.  This error applies to only one of the data files. 

a. Open the data file. 

b. On the Settings menu, Configuration Settings, Edge Estimates tab, 
right click on the Begin Transect Shore Distance box.   

c. Select Open for Edit. 
d. Enter the correct shore distance.  Click OK.  

e. Play the file to see the results.   



WinRiver User's Guide 

page 54 RD Instruments 

 
Figure 17. Open an Item for Edit 
Example – Data was collected using an ADCP depth of 0 meters.  The cor-
rect ADCP depth was 0.2 meters.  This error applies to all of the data files 
collected that day. 

a. Open one of the data files. 

b. On the Settings menu, Configuration Settings, Offsets tab, right click 
on the ADCP Depth box.   

c. Select Open for Edit and Freeze. 

d. Enter the correct ADCP depth.  Click OK. 

e. Play the file to see the results.  The correction will apply to all subse-
quent data files opened. 

 
NOTE.  To return the value to the parameter as collected, right click the 
item and select Use *w.000 Value.   

 

7.4 Subsection a File 
You can use the Ensemble File Subsection box to subsection raw data files 
before display, writing to ASCII files, or printing a display.  WinRiver resets 
all elapsed data counters (Made Good, Length, Time) and total discharge 
values (Q) at the start of your subsection, so it computes the elapsed infor-
mation or discharge for the subsection only.  For example, you could sub-
section the middle 500-meters of a 2-km river transect.  Replaying the sub-
sectioned data would then show the discharge in that 500-m section of the 
river.   

a. Start WinRiver in the Playback mode.  If you are in the Acquire mode, 
click File, Playback Mode.  
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b. On the File menu click Open ADCP File.  Select the data file to be sub-
sectioned. 

c. On the Settings menu, click File Subsection. 

d. To select a portion of the data file, uncheck the Select All Ensembles 
box.  Enter the First Ensemble Number and Last Ensemble Number 
and select OK. 

e. Play the subsectioned data file.  To quickly process the entire data set, 
click Playback, Last Ensemble.  When subsectioning, WinRiver tries to 
jump to the First Ensemble Number in the data file before processing.  
If WinRiver cannot jump to that ensemble number, it resets the data file 
to the beginning of the file.  If WinRiver reaches the end-of-file before 
finding the Last Ensemble Number, it sets the last ensemble number to 
the last ensemble number read from the file. 

f. To return to the entire data file, On the Settings menu, click File Sub-
section. Check the Select All Ensembles box.  Replay the data file. 

7.5 Creating an ASCII-Out Data File 
Playback can be used to create ASCII-Out data files (see “File Naming 
Convention,” page 10).  These files are, as the name implies data files that 
are in a text format that can be directly read by you or imported into other 
post processing software.   

a. Start WinRiver in the Playback mode.  If you are in the Acquire mode, 
click File, Playback Mode.  

b. On the File menu click Open ADCP File.  Select the data file to be 
converted. 

c. On the File menu, click Start ASCII Out.  Type the name of the data 
file you want the data to be written to.  The symbol "->" and the file 
name will indicate successful opening of the file. 

d. WinRiver will jump to the first ensemble, playback the data file, and 
then close the ASCII file. 
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7.6 Creating a Processed Data File 
Playback can be used to create Processed Data files (see “File Naming 
Convention,” page 10).  Processed Data files are used for backward com-
patibility with the DOS based TRANSECT program.   

a. Start WinRiver in the Playback mode.  If you are in the Acquire mode, 
click File, Playback Mode.  

b. On the File menu click Open ADCP File.  Select the data file to be 
converted. 

c. On the File menu, click P-Out.  Type the name of the data file you want 
the data to be written to.   

d. WinRiver will jump to the first ensemble, playback the data file, and 
then close the processed data file. 

7.7 Print a Plot or Display 
a. Start WinRiver in the Playback mode.  If you are in the Acquire mode, 

click File, Playback Mode.  Printing is only available in the Playback 
mode. 

b. On the File menu click Open ADCP File.  Select the data file to be 
played. 

c. Play the data file.  To quickly process the entire data set, click Play-
back, Last Ensemble. 

d. Click on the plot/display to be printed.  The title bar will be highlighted.   

e. On the File menu, click Print Setup.  Select the desired setting and 
printer.   

f. On the File menu click Print Preview.  If the display is acceptable, 
click Print. 
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8 Integrating Depth Sounder, External 
Heading, and GPS Data 
WinRiver can integrate External heading, GPS data, and depth sounder data 
into real-time discharge calculations.  These devices are used when envi-
ronmental conditions make it difficult to get unbiased boat velocity and/or 
depth using bottom tracking.  See “Unable to Bottom Track,” page 121 in 
the Trouble Shooting section of this guide for more details on these condi-
tions.  This section addresses the Depth Sounder, External Heading, and 
GPS requirements for integration.   
Depth Sounder Requirements 

• The depth sounder must be capable of outputting the DBT data 
string via the NMEA0183 format. 

• A third serial port is required on your computer to accept the 
depth sounder data if you are also acquiring differential GPS in 
addition to ADCP data.   

External Heading Requirements 

• The external heading must be capable of outputting the HDT, 
HDG, or PRDID data string via the NMEA0183 format. 

• Two serial port are required on your computer to accept the ex-
ternal heading data in addition to the ADCP data.   

GPS Requirements 

• The GPS must be a high quality, accurate differential GPS sys-
tem. 

• The GPS must be capable of outputting GGA and GSA (optional) 
data strings via the NMEA0183 format.  The GGA string con-
tains GPS positions.  The GSA string provides optional diagnos-
tic information, and it is not required. 

• Two serial ports are required on your computer to accept both 
ADCP and differential GPS data.   
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8.1 How to Use Depth Sounders 
The depth sounder is another external sensor that can be used to track the 
depth of the water.  Areas with weeds or high sediment concentrations may 
cause the ADCP to lose the bottom.  WinRiver will display the corrected 
depth (depth of water from the surface) in the Navigation tabular screen 
(See Figure 19, page 60).   

 
NOTE.  In conditions where a depth sounder is required to measure water 
depth, a GPS is also required to measure the boat speed. 

 

8.1.1 System Interconnections with the Depth Sounder 
a. Connect the depth sounder system to your computer using a serial inter-

face (see your depth sounder manual for details).  You must have a 
depth sounder capable of serial NMEA 0813 output with DBT format in 
feet. 

b. Configure the depth sounder to output the DBT data string via the 
NMEA0183 format. 

c. Connect the ADCP system and the GPS to your computer as described 
in System Interconnection with GPS.  Apply power to the system (see 
the ADCP Technical Manual for details). 

d. Three serial ports are required on your computer to accept the depth 
sounder and differential GPS in addition to ADCP data.  For laptops, 
two PCMCIA serial cards may be used to provide the second and third 
ports. 

8.1.2 Enabling the Depth Sounder Port 
In order to use the depth sounder data, the depth sounder must be enabled.  
To enable depth sounder communications with WinRiver, do the following 
steps.   

a. In the Acquire mode, select the Settings, Communications menu click 
the Add button. 

 

NOTE. WinRiver can be customized to begin pinging as soon as the 
Acquire mode is started.  On the File menu, click Stop Pinging.  You are 
not allowed to change communications parameters while pinging. 

 

b. Choose Depth Sounder, and then click Next.  Choose the COM port 
that the depth sounder is connected to. 

 
NOTE. Three serial ports are required on your computer to accept ADCP, 
differential GPS data, and depth sounder data.   
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c. Click Next.  Enter the Depth Sounder communication Baud Rate, Parity, 
and Stop Bit settings.   

d. Click Next.  Verify the port and communication settings.  Click Next.   

 

NOTE. If you do not want to use depth sounder for this transect, you can 
select the Inactive box.  This will disable depth sounder, but retain the 
communication settings. 

 

e. Click Finish.   

f. Start pinging.  You can select View, Device Logs, Depth Sounder Log.  
That will open a window in which all the characters coming from the 
port assigned for the depth sounder are shown.  If the communication 
parameters are set properly you should see “$ DBT” strings on the dis-
play.   

8.1.3 Using Depth Sounder Data 
Once the Depth Sounder communications port is set up the data is recorded.  
To use and view the Depth Sounder data rather than the ADCP beam 
depths, do the following. 

a. On the Settings, Configuration Settings, DS/GPS tab, select the Use in 
Processing box.  The ADCP beam depths will be replaced by the Depth 
Sounder data.   

b. Under the Setting menu, Configuration Settings, Recording tab you 
can select to collect depth sounder data to an ASCII file (*d.*).   

 

NOTE. The Depth Sounder data is ALWAYS recorded to the raw ADCP 
data file.  The ASCII files (*d.*) are only recorded if requested and are not 
used by WinRiver.. 

 

c. On the Settings, Configuration Settings, DS/GPS tab, enter the depth 
from the surface of the water to the depth sounder's transducer face in 
the Transducer Depth box.    

d. In addition to the Transducer Depth command, you can also add an ad-
ditional offset to reconcile any differences between the ADCP bottom 
track depths and those reported by the DBT NMEA string.  Enter a 
value in the Offset box. 

e. You can apply a scaling factor to the raw NMEA depth sounder output 
by entering a number in the Scale Factor box.  Note that the depths re-
ported by the DBT NMEA string do not include the depth of the 
sounder, so the scaling is applied to the range reported from the depth 
sounder to the bottom.   
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f. Many depth sounders only allow a fixed value of 1500 m/s for sound 
speed.  WinRiver can scale the depth sounder depths by the sound speed 
used by WinRiver by selecting the Correct Speed of Sound box.   

 
Figure 18. Depth Sounder Offsets 
g. Save the configuration file with a unique name by selecting Save Con-

figuration File As from the File menu.  In naming the configuration 
file, use a name that will indicate that the depth sounder is being used in 
place of bottom track depths in the discharge calculation, i.e. 
RDGPS_DS.wrc for GPS and depth sounder.   

 

NOTE.  The decoded data will be displayed in the Navigation Tabular 
view if the Settings, Configuration Settings, DS/GPS tab, Use in 
Processing box is selected.   

 

 
Figure 19. Viewing Depth Sounder Data 
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8.2 How to Use the External Heading 
The external heading is another external sensor that can be used to track the 
heading.  Boats with metal hulls may cause the ADCP’s compass to be bi-
ased.  WinRiver will display the corrected heading in the Standard tabular 
screen (See “Using External Heading Data,” page 62).   

8.2.1 System Interconnections with the External Heading 
a. Connect the external heading system to your computer using a serial in-

terface (see your external heading manual for details).  You must have 
an external heading device capable of serial NMEA 0813 output with 
HDT, HDG, or PRDID format. 

b. Configure the external heading to output the data string via the 
NMEA0183 format. 

c. Connect the ADCP system to your computer as described in the ADCP 
User's Guide.  Apply power to the system. 

d. Two serial ports are required on your computer to accept the external 
heading in addition to ADCP data.   

8.2.2 Enabling the External Heading Port 
In order to use the external heading data, the external heading must be en-
abled.  To enable external heading communications with WinRiver, do the 
following steps.   

a. In the Acquire mode, select the Settings, Communications menu click 
the Add button. 

 

NOTE. WinRiver can be customized to begin pinging as soon as the 
Acquire mode is started.  On the File menu, click Stop Pinging.  You are 
not allowed to change communications parameters while pinging. 

 

b. Choose External Heading, and then click Next.  Choose the COM port 
that the external heading is connected to. 

 
NOTE. Two serial ports are required on your computer to accept ADCP 
data and the external heading data.   

 

c. Click Next.  Enter the external heading communication Baud Rate, Par-
ity, and Stop Bit settings.   

d. Click Next.  Verify the port and communication settings.  Click Next.   

 

NOTE. If you do not want to use external heading for this transect, you can 
select the Inactive box.  This will disable the external heading, but retain 
the communication settings. 
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e. Click Finish.   

f. Start pinging.  You can select View, Device Logs, External Heading 
Log.  That will open a window in which all the characters coming from 
the port assigned for the external heading are shown.  If the communica-
tion parameters are set properly you should see “$__HDT”, “$__HDG” 
or “$PRDID” strings on the display.   

8.2.3 Using External Heading Data 
Once the external heading communications port is set up, the data is re-
corded.  To use and view the external heading data, do the following. 

a. Under the Setting menu, Configuration Settings, Recording tab you 
can select to collect external heading data to an ASCII file (*h.*).   

 

NOTE. The External Heading data is ALWAYS recorded to the raw ADCP 
data file.  The ASCII files (*h.*) are only recorded if requested and are not 
used by WinRiver. 

 

b. You can add an offset to reconcile any differences between the ADCP 
heading and those reported by the external heading NMEA string.  Enter 
a value in the Heading Offset box. 

c. Save the configuration file with a unique name by selecting Save Con-
figuration File As from the File menu.  In naming the configuration 
file, use a name that will indicate that the external heading is being used 
in place of bottom track heading in the discharge calculation, i.e. 
RDGPS_EH.wrc for GPS and external heading.   

 
NOTE.  The decoded data will be displayed in the Standard Tabular view.   

 

 
Figure 20. Viewing External Heading Data 
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8.3 How to Use GPS 
In high flow (flood) or high sediment concentration conditions, the ADCP 
may make biased bottom track measurements.  The bias is caused by two 
different environmental sources:  

• Fluid layer of sediment flowing along the bed of the stream 
(Moving Bottom) 

• High sediment concentration in the water column near the bottom 
(Water Bias) 

The consequences of these environmental sources and the biased ADCP 
bottom track are: 

• Discharge computed with the ADCP is biased low 

• The vessel track (shiptrack) is biased upstream 

 
NOTE. The ADCP is not malfunctioning – but measuring the environment 
as designed. 

 

8.3.1 Using GPS Versus Bottom Track 
When the ADCP cannot make unbiased bottom track measurements, an ex-
ternal differential GPS system should be used as the velocity reference.  
WinRiver can integrate the GPS data, replacing the bottom track velocity to 
compute real-time discharge.  If the ADCP can detect the bottom to obtain 
depth, then there is no need to use a depth sounder.  

In some cases, the suspended sediment concentrations are very high, and 
the ADCP cannot make a valid detection of the bottom depth.  In this case, 
a depth sounder can be used to provide the depth for the real-time discharge 
calculation.  In conditions where a depth sounder is required to measure wa-
ter depth, a GPS is also required to measure the boat speed. 

To use GPS as a vessel speed reference, three conditions must be met: 

1. The GPS must be a high quality, accurate differential GPS system. 

2. The compass used to rotate ADCP velocities to earth coordinates must 
be accurate and unbiased.  The internal ADCP compass must be cor-
rected for magnetic effects caused by any ferromagnetic objects, e.g. 
steel tools or motor, on the boat or in the nearby environment. The 
Compass Correction section describes the procedures to correct the in-
ternal ADCP compass heading data for local magnetic variation and to 
calibrate the compass for one-cycle deviation errors.   These corrections 
will help to reconcile the magnetic coordinate system of the ADCP with 
the GPS true earth coordinate system.  You must be able to acquire valid 
bottom-track data to perform these corrections.  If you anticipate mov-
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ing bottom conditions during flood season, you should determine the 
compass corrections before flood season. 

3. Transects must be made slowly to obtain the best quality discharge data 
when using GPS as the velocity reference.  Slow boat speeds will reduce 
the error contribution to the discharge calculation caused by incorrectly 
rotating the ADCP velocities into the differential GPS earth coordinate 
system.  This rotation is necessary to put both the ADCP velocities and 
the boat velocities determined by the GPS into the same coordinate sys-
tem.   

 
NOTE. Bottom-track must be enabled in order to use the GPS data even 
though it is not used as the velocity reference. 

 

 

NOTE. If you can obtain valid bottom track data, and you use this as your 
reference system, there is no need to perform the compass correction 
procedures.  Both the water and boat velocities are in the same coordinate 
system, and no rotation from one coordinate system to another is required. 

 

8.3.2 System Interconnections with GPS 
a. Connect the GPS system to your computer using a serial (RS- 232 or 

RS- 422) interface (see the GPS Manual for details). 

b. Mount the differential GPS antenna as close to the ADCP as possible – 
less than one meter horizontally is the optimum distance.  Apply power 
to the GPS. 

c. Configure the GPS to output GGA, GSA (optional), and VTG (optional) 
data strings via the NMEA0183 format.  The GGA string contains GPS 
positions.  The GSA string provides optional diagnostic information, 
and it is not required.  The VTG string provides velocity information 
calculated by the GPS. 

d. Connect the ADCP system to your computer using a serial (RS- 232 or 
RS- 422) interface.  Apply power to the system (see the ADCP Techni-
cal Manual for details). 

e. Two serial ports are required on your computer to accept both ADCP 
and differential GPS data.   

8.3.3 Enabling the GPS Port 
To enable GPS communications with WinRiver, do the following steps.   

a. On the Settings, Communications menu click the Add button. 

b. Choose GPS, and then click Next.  Choose the COM port that the GPS 
is connected to. 
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NOTE. Two serial ports are required on your computer to accept both 
ADCP and differential GPS data.   

 

c. Click Next.  Enter the GPS communication Baud Rate, Parity, and Stop 
Bit settings.   

d. Click Next.  Verify the port and communication settings.  Click Next.   

 
NOTE.  Selecting the Inactive box will disable GPS, but retain the 
communication settings. 

 

e. Click Finish.  The GPS data will be recorded to the raw data file.   
Optional Settings 

• GPS Latitude and Longitude data can be saved to a separate 
ASCII file by choosing Record GPS Data on the Settings, Con-
figuration Settings, Recording tab. 

• For best results, make sure the ADCP is using ship coordinates 
(EX10nnn command (default value), where the nnn values are 
set to 0 or 1 as desired) in the Settings, Configuration Settings, 
Commands tab. 

• If desired, you can allow for a lead-time between the GPS posi-
tion updates and the ADCP data.  This is done by inserting a 
value in the GPS Time Delay box in the Settings, Configura-
tion Settings, DS/GPS tab.  For example, if the lead-time is set 
for 1 second, this assumes that the GPS data is one second old 
compared to the ADCP.  The recommended value is zero. 

8.4 Compass Correction 
The following section describes the procedure to correct the ADCP’s com-
pass for use with the GPS data.  The first correction to the compass is for 
local magnetic variation and the second correction is for one-cycle magnetic 
deviation errors.   

 

CAUTION.  Both of these corrections are important because an 
uncorrected difference between the earth coordinate system of the 
differential GPS and the ADCP’s internal magnetic compass will translate 
into significant errors in the discharge calculation.   

 

If you plan on using GPS, it is strongly recommended that you perform the 
compass correction procedures outlined in this section.  A new compass 
correction should be determined if you are working more than 10 to 40 
miles from the site where the last correction was performed, if you will be 
working in significantly different temperatures from the last compass cali-
bration, or if your ADCP mounting has changed. 
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NOTE.  We recommend installing the ADCP with beam 3 forward for 
making discharge measurements (refer to the installation guide) and for 
the compass correction procedures.   If beam 3 is not forward, you will 
need to carefully measure the rotation angle of beam 3. 

 

 

NOTE.  If you have a Rio Grande ADCP with firmware 10.05 or greater, 
perform the Method 3 calibration before you do the Magnetic Variation 
Correction. 

 

8.4.1 Magnetic Variation Correction 
Local magnetic variation correction can be estimated by referring to a chart 
of the local area, but many times this information is not adequately precise.  
Use the following steps to determine the local magnetic variation. 

a. Find a calm low current area where there is no moving bottom affects to 
do the compass correction.  You must be collecting and using GPS data 
and be able to bottom track in the chosen location.   

b. Create or open a workspace file (see “Customizing WinRiver,” page 4) 
that has the Standard, Navigation, and Compass Calibration tabular 
displays, and a Ship Track display. 

c. On the Settings menu, Reference, set the reference to GPS (GGA). 
d. On the Settings, Configuration Settings, Offsets tab, set the Magnetic 

Variation value and compass correction (One Cycle K and One Cycle 
Offset) values to zero.  Ensure that the Beam 3 Misalignment angle is 
set to the Beam 3 misalignment. 

e. Mark a starting point.  This should be a point that you can easily refer-
ence to (an end of a pier, or a stationary marker).  

f. Start WinRiver in the Acquire mode.  Press F4 to start pinging.  Press F5 
to start recording. 

g. Drive a straight track with constant heading (accelerate slowly and 
maintain a slow steady speed) for at least 200 meters (the longer the 
course the better) as shown in Figure 21, page 67.  Monitor the heading 
display in the Standard Tabular view, and adjust your course to stay on 
a constant heading (not a constant course). 
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Figure 21. Reciprocal Constant Heading Tracks for Determining 

Magnetic Variation 
 

h. Record the value of GC-BC from the Compass Calibration Tabular 
screen as shown in Figure 22.  This is the compass error on this course 
(variation + deviation).  Press F5 to stop recording.   

 
Figure 22. Determining Local Magnetic Variation 
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i. Drive a track along the opposite heading direction as shown in 
Figure 21, page 67.  Press F5 to start recording. 

j. Record the value of GC-BC.  Use the average of the two values to esti-
mate the magnetic variation.  Use as many pairs of reciprocal tracks 
along other heading directions as desired to get a better value (a total 
four vectors, that is two track pairs in approximately orthogonal direc-
tions, is recommended).  Average the values of GC-BC for all of the 
tracks.  This averaged value is the local magnetic variation. 

k. Modify the Configuration Settings, Offsets tab and enter the Magnetic 
Variation value.  In the example below, we have entered a magnetic 
variation of 12.2 degrees.   

 
Figure 23. Entering Local Magnetic Variation 

 

NOTE.  In the Acquire mode it is a good idea to rename the configuration 
file to reflect that it has been corrected for magnetic variation.  For 
example, if you original file was RDGPS1.wrc, then the modified file could 
be named RDGPS2.wrc to show that it has undergone one level of 
correction.  In the Playback mode, simply edit the *w.001 file and freeze 
the values to apply them to all subsequent transects.  

 

l. Start WinRiver in the Playback mode.  When the data is played back, 
average the GC-BC value for two reciprocal headings.  This value 
should be close to zero if the correction was made correctly (Figure 24). 

 
Figure 24. Data Corrected for Local Magnetic Variation 
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8.4.2 One-Cycle Compass Correction 
Ferrous objects in the vicinity of the ADCP can affect the internal flux-gate 
compass.  These affects will show up as one and two cycle errors in the 
compass heading.  The one-cycle error can be corrected by using one of two 
methods described later in this section.  The two-cycle error is typically 
negligible, but can be checked by using the AX-command as outlined in the 
Maintenance manual.  Perform the AX-command with the ADCP mounted 
in the boat, and drive the boat in a small circle.  If the two-cycle error is 
more than 0.5 degrees, check to see if there are any large ferrous objects 
close to the ADCP mounting that can be removed. 

There are three methods of compass corrections.  The first two require you 
to drive in a circle, starting and stopping at exactly the same point. Bottom-
track may show that you have not returned to the same location.  This non-
closure error is caused by the one-cycle compass deviation, and it can be 
estimated from the magnitude and direction of the non-closure.   

After you have driven in a circle, the magnitude of the non-closure error is 
indicated by the Distance MG (Made Good) value.  The ratio between dis-
tance made good and the length of the track (Distance MG and Length, 
respectively) is the one-cycle magnitude of the compass error and the one-
cycle offset is the Course MG angle.   

There are three ways to determine and correct this non-closure error.  The 
first procedure is the preferred method for BroadBand and WorkHorse 
ADCPs such as the Sentinel and Monitor.  It provides a more accurate esti-
mation of the one cycle compass error than the second method, but it re-
quires that you have a stable dock or marker that you can drive away from 
in your boat and then return to within 30 cm (1 ft.).  If you do not have a 
marker that will allow this kind of accuracy, use the second procedure to 
determine the one-cycle error.  For both of these procedures, you must be in 
a location where you can obtain valid bottom track data. 

The third method provides the easiest way to calibrate the compass for 
on-cycle errors but it can only be used with the WorkHorse Rio Grande 
ADCPs with firmware version 10.05 and higher.  If you have a Rio 
Grande with an earlier version of firmware, contact RDI to upgrade the 
firmware.  You do not need to be able to collect valid bottom track data for 
this third method to work.  This procedure can be performed at sites with a 
"moving bottom".   
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Method 1 
To reduce the error, do the following steps. 

a. Find a calm low current area where you can obtain valid bottom tracking 
data to perform the compass calibration procedure.  Mark a starting 
point that you can easily return to and maintain position (an end of a 
pier, or a stationary buoy).  You will need to be able to return to this lo-
cation to within about 30 cm (1 ft.) (even closer is better!). 

b. Make sure that bottom track is the velocity reference for the Method 1 
compass calibration procedure.  On the Settings menu, Reference, set 
the reference to Bottom Track. 

c. On the File menu, select Save Configuration File As and create a new 
configuration file from the file that was modified for the magnetic varia-
tion.  We suggest naming the configuration file to reflect that Bottom 
Tracking is being used and that the magnetic variation correction has 
been applied, i.e. *BTM2.wrc. 

d. Create or open a workspace file (see “Customizing WinRiver,” page 4) 
that has the Standard, Navigation, and Compass Calibration tabular 
displays, and a Ship Track display. 

e. Start WinRiver in the Acquire mode.  Press F4 to start pinging.  Press F5 
to start recording.   

f. Drive in a circular course with a circumference of about 1000 meters or 
larger (as large as possible).  It is important to make a large circular 
track to make a good estimate of the one-cycle compass correction fac-
tors, and it is also important to make the path as close to a true circle as 
possible.  Use the Ship Track screen to help make the circular course at 
a slow steady speed.  If your location does not allow you to run a large 
circular course, you can run several continuous circles (say 3 to 5) being 
sure to pass your original starting point as you complete each circle.  
You would then use the combined course length from all of the circles in 
determining the one-cycle errors as described in the following steps. In 
Figure 25, page 71, three circular tracks were made to provide a total 
track length of 1754.50 meters. 
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Figure 25. Method 1 Compass Correction Procedure 
g. Come back as close as you can to the starting point (within 30 cm or 

less).  Press F5 to stop recording.   

h. Record the Course MG, Distance MG, and Length values in the Navi-
gation Tabular display.  For example, in Figure 25, the Course MG is 
234.33°, the Distance MG is 22.79 meters, and the Length is 1754.50 
meters. 

i. Take the ratio between Distance MG and Length; this is the magnitude 
of the one-cycle error (One Cycle K). In our example as shown in 
Figure 26, page 72, you would determine the ratio as 22.79/1754.50 = 
0.0129.  The Course MG 234.33° is the one-cycle error offset (One 
Cycle Offset). 

j. On the Settings, Configuration Settings, Offset tab, enter the values 
for the One Cycle K and One Cycle Offset.  
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Figure 26. Entering the Compass Corrections 
k. If the ADCP is mounted with beam 3 pointed in a direction other than 

forward along the ship’s centerline, determine the clockwise rotation of 
beam 3 relative to the ship’s centerline and insert the value in the Beam 
3 Misalignment box. 

l. Apply the One Cycle K and One Cycle offset corrections to the configu-
ration file that contains the magnetic variation corrections.   

m. Start WinRiver in the Playback mode and replay the data using the cor-
rected configuration file.  The circle non-closure error as indicated by 
Distance MG should now be minimized (Figure 27, page 73).  If the 
compass has been adequately corrected, the ratio of Distance MG to 
Length should be 0.01 or less (2.83/1754.50 = 0.0016). 

n. You can now use the corrected configuration file for acquiring discharge 
measurements. 
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Figure 27. Method 1 Compass Correction Procedure with Correction 

Applied 
 

 

NOTE. It is a good idea to rename the configuration file to reflect that the 
compass corrections have been applied.  For example, if the configuration 
file with magnetic variation has been named *M2.wrc, then the new file 
could be named *M3.wrc to indicate that both the magnetic variation and 
the one-cycle corrections have been applied.  

To apply the corrections to subsequent data files during Playback, right-
click each of the shore estimates boxes and bank type (left/Right) on the 
Settings menu, Configuration Setting, Shore Estimate tab and select 
Use *w.000 value.  The value will become grayed out. Click Apply.  Now 
save the configuration file as a unique name.  When a new data file is 
opened, the shore estimate values will be taken from the *w.000 file and 
the compass corrections will already be applied. 
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Method 2 
If you don’t have a marker available that allows you to return to the same 
location (within 30 cm), you can still determine the one-cycle correction 
factors.  For this procedure, GPS is used as the reference rather than the 
dock or stationary marker used in Method 1.  The magnitude of the non-
closure error is estimated by the magnitude of the BMG-GMG vector, and 
the BMG-GMG angle is the course made good direction.  The ratio be-
tween distance made good and the length of the track (BMG-GMG and 
Length, respectively on the WinRiver display in Figure 29, page 76) is the 
magnitude of the one-cycle compass error and the one-cycle offset is the 
BMG-GMG angle.   

GC - BC

BMG - GMG  

 
Figure 28. GPS Versus Bottom Track 
To reduce the error, do the following steps. 

a. Find a calm low current area where you can obtain valid bottom tracking 
data to perform the compass calibration procedure.  Mark a starting 
point.  You will need to be able to return to this general location to 
within about 3 meters (10 feet). 

b. Make sure that GPS (GGA) is the velocity reference for the method 2 
compass calibration procedure.  On the Settings menu, Reference, set 
the reference to GPS (GGA). 

c. On the File menu, select Save Configuration File As and create a new 
configuration file from the file that was modified for the magnetic varia-
tion.  We suggest naming the configuration file to reflect that GPS is be-
ing used and that the magnetic variation correction has been applied, i.e. 
*S2.wrc. 



 WinRiver User's Guide 

P/N 957-6171-00 (June 2001) page 75 

 
NOTE.  GPS is used for the velocity reference in Method 2, while Bottom-
Track is the reference in Method 1. 

 

d. Create or open a workspace file (see How to Customize WinRiver) that 
has the Standard, Navigation, and Compass Calibration tabular dis-
plays, and a Ship Track display. 

e. Start WinRiver in the Acquire mode.  Press F4 to start pinging.  Press F5 
to start recording.   

f. Drive in a circular course with a circumference of about 1000 meters or 
larger (as large as possible).  It is important to make a large circular 
track to make a good estimate of the one-cycle compass correction fac-
tors, and it is also important to make the path as close to a true circle as 
possible.  Use the Ship Track screen to help make the circular course at 
a slow steady speed.  If your location does not allow you to run a large 
circular course, you can run several continuous circles (say 3 to 10) be-
ing sure to pass as close as possible to your original starting point as you 
complete each circle.  You would then use the combined course length 
from all of the circles in determining the one-cycle errors as described in 
the following steps.  In Figure 29, page 76, three circular tracks were 
made to provide a total track length of 1731.76 m.   

g. Monitor the BMG-GMG vector display in the Compass Calibration 
Tabular display as you come back to your starting location.  Press F5 to 
stop recording.   

h. Record the BMG-GMG vectors (magnitude and direction) and Length 
values.  For example, in Figure 29, page 76, the BMG-GMG Direction 
is 231.6°, the BMG-GMG Magnitude is 21.7 m, and the Length is 
1731.76 m. 

i. Take the ratio between BMG-GMG Magnitude and Length; this is the 
magnitude of the One-Cycle Error (One Cycle K).  In our example as 
shown in Figure 29, page 76, you would determine the ratio as 
21.7/1731.76 = 0.0125.  The BMG-GMG Direction 231.6° is the One-
Cycle Error Offset (One Cycle Offset). 
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Figure 29. Method 2 Compass Correction Procedure  
j. On the Settings, Configuration Settings, Offset tab, enter the values 

for the One Cycle K and One Cycle Offset. 

 
Figure 30. Entering the Corrections for Method 2 Compass 

Correction Procedure  
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k. If the ADCP is mounted with beam 3 pointed in a direction other than 
forward along the ship’s centerline, determine the clockwise rotation of 
beam 3 relative to the ship’s centerline d insert the value in the Beam 3 
Misalignment box.   

 

NOTE.  It is a good idea to rename the configuration file to reflect that the 
compass correction has been applied.  For example, if the configuration file 
with magnetic variation has been named *S2.CFG, then the new file could 
be named *S3.CFG to show that both the magnetic variation and the one-
cycle corrections have been applied.   

 

l. Start WinRiver in the Playback mode and replay the data using the cor-
rected, GPS-referenced configuration file.  The circle non-closure error 
indicated by the BMG-GMG Magnitude will be minimized.  If the 
compass has been adequately corrected, the ratio of BMG-GMG Mag-
nitude to Length should be 0.01 or less (2.4/1731.50 = 0.0013 in 
Figure 31). 

m. You can now use the corrected configuration file for acquiring discharge 
measurements. 

 

NOTE.  RDI recommends using a bottom-track referenced configuration 
file (Method 1).  If you have a Rio Grande ADCP, RDI recommends using 
Method 3. 

 
Figure 31. Method 2 Compass Correction with Correction Applied 
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Method 3 
This procedure is used to correct the Rio Grande’s internal flux-gate com-
pass for one-cycle deviation errors.  The compass correction procedure 
given here can be used in place of the Method 1 or 2 compass correction 
procedures if you are using a Rio Grande with firmware version 10.05 and 
higher. 

 

NOTE.  The Rio Grande firmware has been modified to allow the 
correction of the one-cycle errors with the AF command.  BroadBand and 
other WorkHorse ADCPs, such as the Sentinel and Monitor, do not have 
this capability. 

 

a. Mount the Rio Grande ADCP in the boat as it will be used to acquire 
data.   

b. Start DumbTerm and press the END key to send a BREAK and establish 
communication with the Rio Grande.  Refer to the RDI Tools User's 
Guide and the DumbTerm help file for details on using the DumbTerm 
program.  DumbTerm is a simple “dumb terminal” program that can be 
used to send direct commands to the ADCP.  You will be using the AF-
command to examine the compass performance and correct the one-
cycle magnitude and offset correction factors. 

c. During this procedure, you will drive your boat in continuous, small cir-
cles.  You can accomplish this by adjusting the throttle to just above idle 
and steering either hard left or hard right.  You will want to reduce any 
pitch and roll effects during the turn (do not move about the boat, this 
may cause the boat to change how it sits in the water) and avoid any ac-
celerations.  If you are working on a river, you will find that you drift 
downstream as your perform the circles.  This will not affect the correc-
tion procedure. 

d. Press F3 to turn on the DumbTerm’s logging capability, and enter a de-
sired filename for the log file.   

e. While you continue to drive the boat in circles, type AF at the command 
prompt.  The following represents what you will see on the screen: 

>AF 
----------------------------------------------------------------------- 
                         Field Calibration Procedure 
Choose calibration method: 
     a.  Remove hard iron error (single cycle) only. 
     b.  Remove hard and soft iron error (single + double cycle). 
     c.  Calibration for a single tilt orientation (single + double cycle). 
     d.  Help. 
Quit. 
 

f. Choose option “c” to Calibrate the compass for a single tilt orientation, 
and the following will be displayed: 
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C 
---------------------------------------------------------------------- 
Field Calibration Procedure 
          Calibration for Constant Tilt Applications (e.g., Rivers) 
Select one: 
     a.  Start calibration procedure. 
     b.  Zero calibration coefficients (only constant tilt coefs). 
     c.  Display correction coefficients. 
     d.  Instructions. 
     e.  Quit. 
 

g. Choose option “a” to start the calibration procedure.  As you turn a cir-
cle in the boat, the program will accumulate data as you point in differ-
ent heading directions.  Once the data is accumulated, the total compass 
error will be displayed as highlighted below.  In the example shown, a 
large magnet was place close to the ADCP to create a large one-cycle er-
ror that results in a Total Error of 7.8°.  You will not likely see such a 
large compass error when you perform the calibration yourself. 

A 
----------------------------------------------------------------------- 
                    RDI Compass Error Estimating Algorithm 
 
   Press any key to start taking data after the instrument is setup. 
 
Rotate the unit in a plane until all data samples are acquired... 
   rotate less than 5ø/sec.  Press Q to quit. 
 
 N       NE       E        SE       S       SW        W        NW       N 
 ^                ^                 ^                 ^                 ^ 
  
Accumulating data ...                     
Calculating compass performance ... 
 
                          >>> Total error:   7.8ø <<< 
 
Press D for details or any other key to continue... 
 

h. When prompted, press D for details, and you will see a message similar 
to the following:  

D 
                                                      
HEADING ERROR ESTIMATE FOR THE CURRENT COMPASS CALIBRATION: 
   OVERALL ERROR: 
      Peak Double + Single Cycle Error (should be < 5ø):  ± 7.78ø 
 
   DETAILED ERROR SUMMARY: 
      Single Cycle Error:  ± 8.09ø 
      Double Cycle Error:  ± 1.28ø 
      Largest Double plus Single Cycle Error: ± 9.37ø 
      RMS of 3rd Order and Higher + Random Error:  ± 0.64ø 
 
      Orientation:    Down 
      Average Pitch:   0.05ø         Pitch Standard Dev:    0.77ø 
      Average Roll:    0.22ø         Roll Standard Dev:     0.30ø 
 
Successfully evaluated compass performance for the current compass calibra-
tion. 
 
Press C to display Percent Horizontal Field Components 
     Relative to Calibration or any other key to continue.... 
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i. At this point, check the Pitch and Roll Standard Deviation values as 
highlighted above.  These values should be below 1°.  It is best to use 
data with less than 1° standard deviation in both pitch and roll.  If the 
boat pitched more than 1° during the turn, you will be given a warning 
message that the compass performance data may be suspect, and if the 
boat has pitched more than 3° during the turn, the AF command will 
stop.   

j. Press C at the prompt to display the horizontal field components. 
 
   Percent Horizontal Field Component Relative to Calibration: 
          a0 + a1*cosé + b1*siné + a2*cos2*é + b2*sin2*é 
          a0 =                                             55.895% 
          a1 =                                              6.361% 
          b1 =                                             -4.755% 
          a2 =                                              0.115% 
          b2 =                                             -1.244% 
 
Press any key to continue... 
Calibration parameters have been updated in NRAM. 
 

k. The last message indicates that the compass parameters have been up-
dated to NRAM to correct for one-cycle errors.  Press any key to return 
to the command prompt. 

l. You can now evaluate the corrected compass by typing AX at the com-
mand prompt.  You will need to continue turning in circles to accumu-
late data on all headings as you did for the AF command.  The screen 
display will be as follows: 

>AX 
---------------------------------------------------------------------------- 
                    RDI Compass Error Estimating Algorithm 
 
   Press any key to start taking data after the instrument is setup. 
 
Rotate the unit in a plane until all data samples are acquired... 
   rotate less than 5ø/sec.  Press Q to quit. 
 
 N       NE       E        SE       S       SW        W        NW       N 
 ^                ^                 ^                 ^                 ^ 
Accumulating data ...  
Calculating compass performance ... 
 
                          >>> Total error:   0.8ø <<< 
 
Press D for details or any other key to continue... 
 

m. Note the total compass error shown on the screen (highlighted above).  
This value should now be reduced because the one-cycle errors were 
corrected by the AX command procedure. 

n. At the prompt type D for details to see the following display. 
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HEADING ERROR ESTIMATE FOR THE CURRENT COMPASS CALIBRATION: 
 
   OVERALL ERROR: 
      Peak Double + Single Cycle Error (should be < 5ø):  ± 0.84ø 
 
   DETAILED ERROR SUMMARY: 
      Single Cycle Error:  ± 0.29ø  
      Double Cycle Error:  ± 0.66ø 
      Largest Double plus Single Cycle Error: ± 0.94ø 
      RMS of 3rd Order and Higher + Random Error:  ± 0.60ø 
 
      Orientation:    Down 
      Average Pitch:   0.21ø         Pitch Standard Dev:    0.78ø 
      Average Roll:    0.17ø         Roll Standard Dev:     0.27ø 
 
Successfully evaluated compass performance for the current compass calibra-
tion. 
 
    Press C to display Percent Horizontal Field Components 
       Relative to Calibration or any other key to continue.... 
 

o. Press any key to complete the compass evaluation.  As you can see from 
the display summary above, the one-cycle error was reduced from 8.09° 
(see step h) to 0.29°.  Note that the double-cycle error was not corrected.  
For typical deployments this value will be much smaller.  In the example 
data shown above, a large magnet was in the vicinity of the ADCP caus-
ing the relatively large double cycle error. 

p. You can now use the Rio Grande with its corrected compass and a con-
figuration file that contains the magnetic variation correction to collect 
discharge measurement data with integrated GPS.   
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8.5 Bottom Track Output Data Format 
If Navigation (GGA, VTG, and/or GSA) or Depth Sounder (DBT) is en-
abled in the WinRiver configuration file, the data in the Bottom Track raw 
data structure is replaced with the navigation data. 

 BIT POSITIONS  

BYTE 7 6 5 4 3 2 1 0  

1 BOTTOM-TRACK ID LSB 00h 

2  MSB 06h 

3 BT PINGS PER ENSEMBLE {BP} LSB 

4  MSB 

5 BT DELAY BEFORE RE-ACQUIRE {BD} or 

6 GPS (GGA) LONGITUDE (PART 1) 
LSB 

7 BT CORR MAG MIN {BC}  

8 BT EVAL AMP MIN {BA}  

9 BT PERCENT GOOD MIN {BC}  

10 BT MODE {BM}  

11 BT ERR VEL MAX {BE} LSB 

12  MSB 

13 RESERVED or 

14 GPS (GGA) LATITUDE 
LSB 

15  

16  
MSB 

17 BEAM#1 BT RANGE LSB 

18  MSB 

19 BEAM#2 BT RANGE LSB 

20  MSB 

21 BEAM#3 BT RANGE LSB 

22  MSB 

23 BEAM#4 BT RANGE LSB 

24  MSB 

25 BEAM#1 BT VEL LSB 

26  MSB 

Continued next page 
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Continued from previous page 

27 BEAM#2 BT VEL LSB 

28  MSB 

29 BEAM#3 BT VEL LSB 

30  MSB 

31 BEAM#4 BT VEL LSB 

32  MSB 

33 BEAM#1 BT CORR.  

34 BEAM#2 BT CORR.  

35 BEAM#3 BT CORR.  

36 BEAM#4 BT CORR.  

37 BEAM#1 EVAL AMP  

38 BEAM#2 EVAL AMP  

39 BEAM#3 EVAL AMP  

40 BEAM#4 EVAL AMP  

41 BEAM#1 BT %GOOD  

42 BEAM#2 BT %GOOD  

43 BEAM#3 BT %GOOD  

44 BEAM#4 BT %GOOD  

45 REF LAYER MIN {BL} or LSB 

46 GGA Altitude value (m) x 10 + 32768 MSB 

47 REF LAYER NEAR {BL} or 

48 GPS (GGA) LONGITUDE (PART 2) 
MSB 

49 REF LAYER FAR {BL} or LSB 

50 DBT (see note) MSB 

51 BEAM 1 REF LAYER VEL or LSB 

52 GGA East/West velocities in mm/s (with reversed sign) MSB 

53 BEAM 2 REF LAYER VEL or LSB 

54 GGA North/South velocity in mm/s (with reversed sign) MSB 

55 BEAM 3 REF LAYER VEL or  

56 VTG East/West velocities in mm/s (with reversed sign)  

57 BEAM 4 REF LAYER VEL or  

58 VTG North/South velocity in mm/s (with reversed sign)  
Continued next page 
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Continued from previous page 

59 BM#1 REF CORR or GSA VDOP value  

60 BM#2 REF CORR or GSA PDOP value  

61 BM#3 REF CORR or GSA # of satellites  

62 BM#4 REF CORR FLAG  

63 BM#1 REF INT or GSA satellite 5 used in solution  

64 BM#2 REF INT or GSA satellite 6 used in solution  

65 BM#3 REF INT or GGA quality (0-invalid, 1-GPS fix, 2-DGPS fix)  

66 BM#4 REF INT or GGA HDOP value x 10  

67 BM#1 REF %GOOD or GSA satellite 1 used in solution  

68 BM#2 REF %GOOD or GSA satellite 2 used in solution  

69 BM#3 REF %GOOD or GSA satellite 3 used in solution  

70 BM#4 REF %GOOD or GSA satellite 4 used in solution  

71 BT MAX. DEPTH {BX} LSB 

72  MSB 

73 BM#1 RSSI AMP  

74 BM#2 RSSI AMP  

75 BM#3 RSSI AMP  

76 BM#4 RSSI AMP  

77 GAIN  

 78 (*SEE BYTE 17) MSB 

79 (*SEE BYTE 19) MSB 

80 (*SEE BYTE 21) MSB 

81 (*SEE BYTE 23) MSB 
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Table  4: Binary Bottom-Track Data Format 
The LSB is always sent first.  The WorkHorse Commands and Output Data Format 
guide has descriptions of the commands used to set these values. 

Hex Digit Binary 
Byte 

Field Description 

1-4 1,2 ID Code Stores the bottom-track data identification word (00 06h). 

5-8 3,4 BP / BT Pings 
per ensemble 

Stores the number of bottom-track pings to average together 
in each ensemble (BP-command).  If BP = 0, the ADCP does 
not collect bottom-track data.  The ADCP automatically ex-
tends the ensemble interval (TE) if (BP +WP) x TP > TE. 

Scaling:  LSD = 1 ping; Range = 0 to 999 pings 

9-12 5,6 BD / BT delay 
before reacquire 
or GGA Longi-
tude part 1 

Stores the number of ADCP ensembles to wait after losing 
the bottom before trying to reacquire it (BD-command). 

Scaling:  LSD = 1 ensemble; Range = 0 to 999 ensembles 

If navigation (GGA) is enabled the GGA Longitude in Binary 
Angular Measure (BAM) will be displayed.  Longitude in 
degrees/180 x 2147483647.  East = positive, West = nega-
tive. 

13,14 7 BC / BT Corr 
Mag Min 

Stores the minimum correlation magnitude value (BC-
command). 

Scaling:  LSD = 1 count; Range = 0 to 255 counts 

15,16 8 BA / BT Eval 
Amp Min 

Stores the minimum evaluation amplitude value (BA-
command). 

Scaling:  LSD = 1 count; Range = 1 to 255 counts 

17,18 9 BG / BT %Gd 
Minimum 

Stores the minimum percentage of bottom-track pings in an 
ensemble that must be good to output velocity data (BG-
command). 

19,20 10 BM / BT Mode Stores the bottom-tracking mode (BM-command). 

21-24 11,12 BE / BT Err Vel 
Max 

Stores the error velocity maximum value (BE-command). 

Scaling:  LSD = 1 mm/s; Range = 0 to 5000 mm/s (0 = did 
not screen data) 

25-32 13-16 GGA Latitude If navigation (GGA) is enabled the GGA Latitude in Binary 
Angular Measure (BAM) will be displayed.  Latitude in de-
grees/180 x 2147483647.  North = positive, South = nega-
tive. 

33-48 17-24 BT Range / 
Beam #1-4 BT 
Range 

Contains the two lower bytes of the vertical range from the 
ensonified sea bottom (or surface to the ADCP altitude) as 
determined by each beam.  This vertical range does not 
consider the effects of pitch and roll.  When bottom detec-
tions are bad, BT Range = 0.  See bytes 78 through 81 for 
MSB description and scaling. 

Scaling:  LSD = 1 cm; Range = 0 to 65535 cm 

49-64 25-32 BT Velocity / 
Beam #1-4 BT 
Vel 

The meaning of the velocity depends on the EX (coordinate 
system) command setting.  The four velocities are as follows: 

a) Beam Coordinates:  Beam 1, Beam 2, Beam 3, Beam 4 

b) Instrument Coordinates: 1 → 2, 4 → 3, toward face, error 

c) Ship Coordinates:  Starboard, Forward, Upward, Error 

d) Earth Coordinates: East, North, Upward, Error 

Continued next page 
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Table  4: Binary Bottom-Track Data Format (continued) 
Hex Digit Binary 

Byte 
Field Description 

65-72 33-36 BTCM / Beam 
#1-4 BT Corr. 

Contains the correlation magnitude in relation to the sea 
bottom (or surface) as determined by each beam.  Bottom-
track correlation magnitudes have the same format and 
scale factor as water-profiling magnitudes. 

73-80 37-40 BTEA / Beam #1-
4 

BT Eval Amp 

Contains the evaluation amplitude of the matching filter used 
in determining the strength of the bottom echo. 

Scaling:  LSD = 1 count; Range = 0 to 255 counts 

81-88 41-44 BTPG / Beam 
#1-4 BT %Good 

Contains bottom-track percent-good data for each beam, 
which indicate the reliability of bottom-track data.  This data 
is the percentage of bottom-track pings that have passed the 
ADCP’s bottom-track validity algorithm during an ensemble. 

Scaling:  LSD = 1 percent; Range = 0 to 100 percent 

89-92   45,46  Ref Layer Min 

GGA Altitude 

Stores the minimum layer size of the BT water-reference 
layer (BL-command).   

Scaling (minimum layer size): LSD = 1 dm; Range = 0 to 999 
dm 

Scaling (near/far boundaries): LSD = 1 dm; Range = 0 to 
9999 dm 

If Navigation (GGA) is enabled in the WinRiver configuration 
file, the GGA altitude value (m) x 10 + 32768 will be dis-
played. 

93-96 47,48 Near Ref or GPS 
(GGA) Longitude 
part 2 

Stores the near boundary of the BT water-reference layer 
(BL-command).   

Scaling (minimum layer size): LSD = 1 dm; Range = 0 to 999 
dm 

Scaling (near/far boundaries): LSD = 1 dm; Range = 0 to 
9999 dm 

If navigation (GGA) is enabled the GGA Longitude in Binary 
Angular Measure (BAM) will be displayed.  Longitude in 
degrees/180 x 2147483647.  East = positive, West = nega-
tive. 

97-100 49,50 Layer Far 

DBT depth 

Stores the far boundary of the BT water-reference layer (BL-
command).   

Scaling (minimum layer size): LSD = 1 dm; Range = 0 to 999 
dm 

Scaling (near/far boundaries): LSD = 1 dm; Range = 0 to 
9999 dm 

If Depth Sounder (DBT) is enabled in the WinRiver configu-
ration file, the DBT depth in centimeters will be displayed. 

101-104 51-52 Ref Vel / Beam 
#1 Ref Layer Vel 

GGA vel 

Contains velocity data for the water reference layer for beam 
1.  Reference layer velocities have the same format and 
scale factor as water-profiling velocities.  WorkHorse Com-
mands and Output Data Format Guide (BL-command) ex-
plains the water reference layer. 

If Navigation (GGA) is enabled in the WinRiver configuration 
file, the GGA East/West velocities in mm/s (with reversed 
sign) will be displayed. 
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Table  4: Binary Bottom-Track Data Format (continued) 
Hex Digit Binary 

Byte 
Field Description 

105-108 53-54 Ref Vel / Beam 
#2 Ref Layer Ve 

GGA vel 

Contains velocity data for the water reference layer for beam 
2.  Reference layer velocities have the same format and 
scale factor as water-profiling velocities.  WorkHorse Com-
mands and Output Data Format Guide (BL-command) ex-
plains the water reference layer. 

If Navigation (GGA) is enabled in the WinRiver configuration 
file, the GGA North/South velocities in mm/s (with reversed 
sign) will be displayed. 

109-112 55-56 Ref Vel / Beam 
#3 Ref Layer Vel 

VTG vel 

Contains velocity data for the water reference layer for beam 
3.  Reference layer velocities have the same format and 
scale factor as water-profiling velocities.  WorkHorse Com-
mands and Output Data Format Guide (BL-command) ex-
plains the water reference layer. 

If Navigation (VTG) is enabled in the WinRiver configuration 
file, the VTG East/West velocities in mm/s (with reversed 
sign) will be displayed. 

113-116 57-58 Ref Vel / Beam 
#4 Ref Layer Vel 

VTG vel 

Contains velocity data for the water reference layer for beam 
4.  Reference layer velocities have the same format and 
scale factor as water-profiling velocities.  WorkHorse Com-
mands and Output Data Format Guide (BL-command) ex-
plains the water reference layer. 

If Navigation (VTG) is enabled in the WinRiver configuration 
file, the VTG North/South velocities in mm/s (with reversed 
sign) will be displayed. 

117-118 59 RLCM/Bm #1 
Ref Corr 

GSA VDOP 

Contains correlation magnitude data for the water reference 
layer for beam 1.  Reference layer correlation magnitudes 
have the same format and scale factor as water-profiling 
magnitudes. 

If Navigation (GSA) is enabled in the WinRiver configuration 
file, the GSA VDOP value will be displayed. 

119-120 60 RLCM/Bm #2 
Ref Corr 

GSA PDOP 

Contains correlation magnitude data for the water reference 
layer for beam 2.  Reference layer correlation magnitudes 
have the same format and scale factor as water-profiling 
magnitudes. 

If Navigation (GSA) is enabled in the WinRiver configuration 
file, the GSA PDOP value will be displayed. 

121-122 61 RLCM/Bm #3 
Ref Corr 

GGA # of satel-
lites 

Contains correlation magnitude data for the water reference 
layer for beam 3.  Reference layer correlation magnitudes 
have the same format and scale factor as water-profiling 
magnitudes. 

If Navigation (GGA) is enabled in the WinRiver configuration 
file, the GGA # of satellites will be displayed. 

123-124 62 RLCM/Bm #4 
Ref Corr 

Contains correlation magnitude data for the water reference 
layer for each beam.  Reference layer correlation magni-
tudes have the same format and scale factor as water-
profiling magnitudes. 

125-126 63 Bm #1 Ref Int or 
GSA Sat 5 

Contains echo intensity data for the reference layer for beam 
1.  Reference layer intensities have the same format and 
scale factor as water-profiling intensities. 

If Navigation (GSA) is enabled in the WinRiver configuration 
file, the GSA satellite 5 used in the solution will be displayed. 
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Table  4: Binary Bottom-Track Data Format (continued) 
Hex Digit Binary 

Byte 
Field Description 

127-128 64 Bm #2 Ref Int or 
GSA Sat 6 

Contains echo intensity data for the reference layer for beam 
2. 

If Navigation (GSA) is enabled in the WinRiver configuration 
file, the GSA satellite 6 used in the solution will be displayed. 

129-130 65 Bm #3 Ref Int or 
GGA Quality 

Contains echo intensity data for the reference layer for beam 
3. 

If Navigation (GGA) is enabled in the WinRiver configuration 
file, the GGA quality (0 = invalid, 1 = GPS fix, 2 = DGPS fix) 
will be displayed. 

131-132 66 Bm #4 Ref Int or 
GGA HDOP 

Contains echo intensity data for the reference layer for beam 
4. 

If Navigation (GGA) is enabled in the WinRiver configuration 
file, the GGA HDOP value x 10 will be displayed. 

133-134 67-70 RLPG/Bm #1 Ref 
%Good 

GSA Sat 1 

Contains percent-good data for the water reference layer for 
beam 1.  Reference layer percent-good data indicates the 
reliability of reference layer data.  They are the percentages 
of bottom-track pings that have passed a reference layer 
validity algorithm during an ensemble. 

If Navigation (GSA) is enabled in the WinRiver configuration 
file, the GSA satellite 1 used in the solution will be displayed. 

Scaling:  LSD = 1 percent; Range = 0 to 100 percent 

135-136 68 RLPG/Bm #2 Ref 
%Good 

GSA Sat 2 

Contains percent-good data for the water reference layer for 
beam 2.  Reference layer percent-good data indicates the 
reliability of reference layer data.  They are the percentages 
of bottom-track pings that have passed a reference layer 
validity algorithm during an ensemble. 

If Navigation (GSA) is enabled in the WinRiver configuration 
file, the GSA satellite 2 used in the solution will be displayed. 

Scaling:  LSD = 1 percent; Range = 0 to 100 percent 

137-138 69 RLPG/Bm #3 Ref 
%Good 

GSA Sat 3 

Contains percent-good data for the water reference layer for 
beam 3.  Reference layer percent-good data indicates the 
reliability of reference layer data.  They are the percentages 
of bottom-track pings that have passed a reference layer 
validity algorithm during an ensemble. 

If Navigation (GSA) is enabled in the WinRiver configuration 
file, the GSA satellite 3 used in the solution will be displayed. 

Scaling:  LSD = 1 percent; Range = 0 to 100 percent 

139-140 70 RLPG/Bm #4 Ref 
%Good 

GSA Sat 4 

Contains percent-good data for the water reference layer for 
beam 4.  Reference layer percent-good data indicates the 
reliability of reference layer data.  They are the percentages 
of bottom-track pings that have passed a reference layer 
validity algorithm during an ensemble. 

If Navigation (GSA) is enabled in the WinRiver configuration 
file, the GSA satellite 4 used in the solution will be displayed. 

Scaling:  LSD = 1 percent; Range = 0 to 100 percent 

141-144 71,72 BX / BT Max. 
Depth 

Stores the maximum tracking depth value (BX-command). 

Scaling:  LSD = 1 decimeter; Range = 80 to 9999 decimeters 
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Table  4: Binary Bottom-Track Data Format (continued) 
Hex Digit Binary 

Byte 
Field Description 

145-146 73-76 RSSI/Bm #1 
RSSI Amp 

Contains the Receiver Signal Strength Indicator (RSSI) value 
in the center of the bottom echo as determined by each 
beam. 

Scaling: LSD ≈ 0.45 dB per count; Range = 0 to 255 counts  

147-148 74 RSSI/Bm #2 
RSSI Amp 

Contains the Receiver Signal Strength Indicator (RSSI) value 
in the center of the bottom echo as determined by each 
beam. 

Scaling: LSD ≈ 0.45 dB per count; Range = 0 to 255 counts  

149-150 75 RSSI/Bm #3 
RSSI Amp 

Contains the Receiver Signal Strength Indicator (RSSI) value 
in the center of the bottom echo as determined by each 
beam. 

Scaling: LSD ≈ 0.45 dB per count; Range = 0 to 255 counts  

151-152 76 RSSI/Bm #4 
RSSI Amp 

Contains the Receiver Signal Strength Indicator (RSSI) value 
in the center of the bottom echo as determined by each 
beam. 

Scaling: LSD ≈ 0.45 dB per count; Range = 0 to 255 counts  

153,154 77 GAIN Contains the Gain level for shallow water (WJ-command). 

155-162 78-81 BT Range MSB / 
Bm #1-4 

Contains the most significant byte of the vertical range from 
the ADCP to the sea bottom (or surface) as determined by 
each beam.  This vertical range does not consider the effects 
of pitch and roll.  When bottom detections are bad, BT 
Range=0.  See bytes 17 through 24 for LSB description and 
scaling. 

Scaling: LSD = 65,536 cm, Range = 65,536 to 16,777,215 
cm 
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8.6 Navigation Data Output Data Format 
WinRiver can read in, decode, and record ensembles from an ADCP and 
NMEA data from some specific (i.e. GPS and attitude sensors) external de-
vices.  WinRiver stores this data in the *r.000 raw data file (leaving all 
original data input from the ADCP in its original format).   

Table  5: Navigation Data Structure 
HEADER 

(6 BYTES + [2 x No. OF DATA TYPES]) 
FIXED LEADER DATA  

(53 BYTES) ALWAYS OUTPUT 

VARIABLE LEADER DATA 
(65 BYTES)  
VELOCITY 

(2 BYTES + 8 BYTES PER DEPTH CELL) 
CORRELATION MAGNITUDE 

(2 BYTES + 4 BYTES PER DEPTH CELL) 
ECHO INTENSITY 

(2 BYTES + 4 BYTES PER DEPTH CELL) 

WD-command  

WP-command 

PERCENT GOOD 
(2 BYTES + 4 BYTES PER DEPTH CELL) 

BP-command BOTTOM TRACK DATA 
(81 BYTES) 

DEPTH SOUNDER (DBT) 
(38 BYTES) 
GPS GGA 

(94 BYTES) 
GPS VTG 

(45 BYTES) 
GPS GSA 

(60 BYTES) 

NMEA Strings 

EXTERNAL HEADING HDT, HDG, or PRDID) 
(38 BYTES) 
RESERVED 
(2 BYTES) ALWAYS OUTPUT CHECKSUM 
(2 BYTES) 

 

 
NOTE.  The other formats (Header, Fixed Leader Data, etc.) are explained 
in the WorkHorse Commands and Output Data Format guide. 

 

Use the Binary Header Data Format (see the WorkHorse Commands and 
Output Data Format guide) to locate the offset to the specific ID of the data 
type you wish to decode.  The table below shows the navigation IDs. 

Table  6: Fixed Leader Navigation ID Word 
ID Description 

0x2100 $xxDBT 

0x2101 $xxGGA 

0x2102 $xxVTG 

0x2103 $xxGSA 

0x2104 $xxHDT, $xxHDG or $PRDID 
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Once the ID of the data type is located use the data format section to locate 
the bytes you wish to decode using the data format for your ADCP. 

8.7 General NMEA Data Format 
Much of the following information was abstracted from the NMEA 0183 
standard.  Discussion is limited to NMEA strings that WinRiver under-
stands.  All NMEA messages are ASCII strings with the general format as 
shown in Table 7. 

Table  7: NMEA Data Format 
String Description 

$ HEX 24 – start of sentence 

<Address field> Approved address fields consist of five characters defined by the NMEA 0183 
standard. The first two characters are the TALKER identifier. The next three 
characters identify the message. 

The proprietary address field consists of the proprietary character “P” followed 
by a three-character Manufacturer’s Mnemonic Code, used to identify the 
TALKER issuing a proprietary sentence, and any additional characters as 
required.  

(WinRiver accepts any two valid characters as the TALKER identifier in 
approved address fields.) 

(RD Instruments uses the RDI Mnemonic Code for proprietary address fields, 
even though it is assigned to Radar Devices. WinRiver also uses the 
unassigned ADC Mnemonic Code for its own data files). 

[“,”<data field>] 
. 
. 
. 
[“,”<data field>] 

Zero or more data fields, each preceded by a “,” (comma, HEX 2C) delimiter. 

The number of data fields and their content are determined by the address field. 

Data fields may be null (contain no characters). The comma delimiter is 
required even when a data field is null. 

[“*”checksum field ] Checksum 

The checksum is the 8-bit exclusive OR (no start or stop bits) of all characters in 
the sentence, including “,” delimiters, between but not including the “$” and the 
“*” delimiters. 

The hexadecimal value of the most significant and least significant 4 its of the 
result are converted to two ASCII characters (0-9, A-F) for transmission, The 
most significant character is transmitted first.  

<CR><LF> HEX 0D 0A – End of sentence 
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Data Fields 

Detailed descriptions of each message WinRiver uses are provided below. 
These descriptions use format specifiers for data fields.  The meanings of 
some of the format specifiers are listed in Table 8.  

Table  8: Data Fields 
Field Description 

hhmmss.ss A mixed fixed/variable length time field. 2 fixed digits of hours, 2 fixed digits of 
minutes, 2 fixed digits of seconds, and a variable number of digits for decimal-fraction 
of seconds.  

Leading zeros are always included for hours, minutes, and seconds to maintain fixed 
length. The decimal point and associated decimal-fraction are optional if full 
resolution is not required. 

x.x A variable length integer or floating numeric field with optional leading and trailing 
zeros. The decimal point and associated decimal-fraction are optional if full resolution 
is not required.  (example: 73.10 = 73.1 = 073.1 = 73). 

A negative sign “-“ (HEX 2D) is the first character if the value is negative. The sign is 
omitted if value is positive.  

hh A fixed length HEX number. The most significant digit is on the left. 
a 
aa 
aaa 
etc. 

A fixed length alpha field. This type of field contains a fixed number of upper-case or 
lower-case alpha characters.  

In all strings recognized by WinRiver, all these fields have a length of one character. 
x 
xx 
xxx 
etc. 

A fixed length numeric field. This type of field contains a fixed number of numeric 
characters (0 - 9).  

Some fields allow negative values. If needed, a negative sign “-“ (HEX 2D) is the first 
character, increasing the length of the field by one. The sign is omitted if value is 
positive. 

A A single character status field.  

A = Yes, Data Valid, or Warning Flag Clear.  

V = No, Data Invalid, or Warning Flag Set. 

Other single 
letter 

A single character field with fixed content. The letter is the content of the data field.  

When used below, the HEX value of the letter is also given. 
 

 

NOTES.  Spaces should not be used anywhere in these NMEA strings.  
Spaces may only be used in variable text fields.  No NMEA string 
recognized by WinRiver uses a variable text field. 

If data is not available or unreliable, a null field is used.  A null field is a 
field with no characters in it.  When a null field is present, two delimiters 
(comma, *, or <CR>) are found side by side.  A null field does NOT contain 
the zero character (HEX 30), the ASCII NUL character (HEX 00), a space 
(HEX 20), or other character. 

WinRiver ignores some fields when it decodes messages.  The fields it 
reads are explained in “NMEA Input,” page 93. 
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8.8 NMEA Input 
The messages WinRiver reads are standard DBT, GGA, VTG, GSA, and 
HDT, HDG or PRDID messages.  

8.8.1 DBT – Depth Below Transducer 
Water depth referenced to the transducer 

$__DBT,x.x,f,x.x,M,x.x,F*hh<CR><LF> 

Table  9: DBT NMEA Format 
Field Description 

1* x.x Water depth, feet 

2 f HEX 66 

3 x.x Water depth, Meters 

4 M HEX 4D 

5 x.x Water depth, Fathoms 

6 F HEX 46 

* This field is used by WinRiver. 
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8.8.2 GGA – Global Positioning System Fix Data 
Time, position, and fix related data for a GPS receiver.  
$__GGA,hhmmss.ss,llll.ll,a,yyyy.yy,a,x,xx,x.x,x.x,M,x.x,M,x.x,xxxx*hh<CR><LF> 

Table  10: GGA NMEA Format 
Field Description 
1* hhmmss.ss UTC of position - 2 fixed digits of hours, 2 fixed digits of minutes, 2 fixed digits of 

seconds, and a variable number of digits for decimal-fraction of seconds. Leading 
zeros are always included for hours, minutes, and seconds to maintain fixed length. 
The decimal point and associated decimal-fraction are optional if full resolution is not 
required.  

2* llll.ll Latitude - Two fixed digits of degrees, 2 fixed digits of minutes, and a variable number 
of digits for decimal-fraction of minutes. Leading zeros are always included for 
degrees and minutes to maintain fixed length of the first 4 chars. The decimal point 
and associated decimal-fraction are optional if full resolution is not required.  

3* a Latitude hemisphere. N or S. 
4* yyyy.yy Longitude - 3 fixed digits of degrees, 2 fixed digits of minutes, and a variable number 

of digits for decimal-fraction of minutes. Leading zeros are always included for 
degrees and minutes to maintain fixed length of the first 5 chars. The decimal point 
and associated decimal-fraction are optional if full resolution is not required.  

5* a Longitude hemisphere. E or W. 
6* x GPS Quality indicator:   

0 = fix not available or invalid 
1 = GPS fix 
2 = Differential GPS fix  
3 = GPS PPS Mode, fix valid 
4 = Real Time Kinematic. System used in RTK mode with fixed integers 
5 = Float RTK. Satellite system used in RTK mode, floating integers 
6 = Estimated (dead reckoning) mode 
7 = Manual Input Mode 
8 = Simulator mode 
This shall not be a null field. 

7* xx Number of satellites in use, 00 – 12, may be different from the number in view 
8 x.x Horizontal dilution of precision 
9* x.x Antenna altitude above/below mean-sea-level (geoid) 
10 M HEX 4D. Units of antenna altitude, meters 
11 x.x Geoidal separation. The difference between the WGS-84 earth ellipsoid and mean-

sea-level (geoid), “-“ = mean-sea-level below ellipsoid. 
12 M HEX 4D. Units of geoidal separation, meters 
13 x.x Age of Differential GPS data. Time in seconds since last SC104 Type 1 or 9 update, 

null field when DGPS is not used. 
14 xxxx Differential reference station ID, 0000-1023 

* This field is used by WinRiver. 
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8.8.3 VTG – Track Made Good and Ground Speed 
The actual track made good and speed relative to the ground.  

$__VTG,x.x,T,x.x,M,x.x,N,x.x,K,a*hh<CR><LF> 

Table  11: VTG NMEA Format 
Field Description 

1* x.x Track, degrees true 

2 T HEX 54 

3* x.x Track, degrees magnetic 

4 M HEX 4D 

5 x.x Speed, knots 

6 N HEX 4E 

7* x.x Speed, km/hr 

8 K HEX 4B 

9 a Mode indicator 
A=Autonomous mode 
D=Differential mode 
E=Estimated (dead reckoning) mode 
M=Manual input mode 
S=Simulator mode 
N=Data not valid 
This shall not be a null field. 

* This field is used by WinRiver. 

8.8.4 GSA – GPS DOP and Active Satellites 
GPS receiver operating mode, satellites used for navigation and DOP 
values. 

$__GSA,a,x,xx,xx,xx,xx,xx,xx,xx,xx,xx,xx,xx,xxx.x,x.x,x.x*hh<CR><LF> 

Table  12: GSA NMEA Format 
Field Description 

1* a Mode 
M = Manual, forced to operate in 2D or 3D mode 
A = Automatic, allowed to automatically switch 2D/3D 

2* x Mode 
1 = Fix not available 
2 = 2D 
3 = 3D 

3 – 14* xx PRN number of Satellites used in solution (null for unused fields) 

15* x.x PDOP 

16* x.x HDOP 

17* x.x VDOP 

* This field is used by WinRiver. 
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8.8.5 HDT – Heading – True 
Actual vessel heading in degrees True produced by any device or system 
producing true heading.  

$__HDT,x.x,T *hh<CR><LF> 

Table  13: HDT NMEA Format 
Field Description 

1* x.x Heading, degrees True 

2 T HEX 54 

* This field is used by WinRiver. 

8.8.6 HDG – Heading, Deviation, and Variation 
Heading (magnetic sensor reading), which if corrected for deviation, will 
produce Magnetic heading, which if offset by variation will provide True 
heading. 

$__HDG,x.x,x.x,a,x.x,a*hh<CR><LF> 

Table  14: HDG NMEA Format 
Field Description 

1* x.x Magnetic sensor heading, degrees 

2* x.x Magnetic deviation, degrees  

This field and the following direction field are null if deviation is unknown.  

3* a Direction of magnetic deviation. E or W.  

4* x.x Magnetic variation, degrees 

This field and the following direction field are null if variation is unknown. 

5* a Direction of magnetic variation. E or W.  

* This field is used by WinRiver. 

To obtain Magnetic Heading:  

a. Add Easterly deviation (E) to Magnetic Sensor Reading.  

b. Subtract Westerly deviation (W) from Magnetic Sensor Reading. 

To obtain True Heading: 

a. Add Easterly variation (E) to Magnetic Heading. 

b. Subtract Westerly variation (W) from Magnetic Heading. 
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8.8.7 PRDID – Heading, Pitch, and Roll 
RDI defines a proprietary NMEA message that contains heading, pitch, and 
roll data.  

$PRDID,x.x,x.x,x.x,*hh<CR><LF> 

Table  15: PRDID NMEA Format 
Field Description 

1 x.x Vessel Pitch, degrees. + = bow up. 

2 x.x Vessel Roll, degrees. + = port up.  

3* x.x Vessel Heading, degrees True 

* This field is used by WinRiver. 

8.9 Further Information About NMEA Strings 
Users who need full details about NMEA data strings can find more infor-
mation in the NMEA 0183 standard, available from the National Marine 
Electronics Association at.  

P O Box 3435  

New Bern, NC  

28564-3435 

252-638-2626 (voice) 

252-638-4885 (fax) 

nmea@coastalnet.com (e-mail)  

http://www.nmea.org/ (web site) 
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9 ADCP Measurement Basics 
The ADCP is an Acoustic Doppler Current Profiler.  It measures vertical 
profiles of the water’s velocity using acoustic energy.  A pulse of energy 
(known as a ping) is transmitted into the water much like a submarine’s 
SONAR but at much higher frequencies.  This energy is reflected off parti-
cles suspended in (and moving with) the water and some of it returns to the 
ADCP.  The ADCP measures the Doppler shift (change in frequency) of the 
reflected energy and from this, computes the velocity of the water relative 
to the ADCP.  We won’t go into the details in this manual.  If you would 
like to learn more about how the ADCP measures velocity, please read the 
BroadBand ADCP Primer. 

The ADCP also measures its own speed and direction across the bottom of 
the channel using the same technique used to measure the velocity of the 
water.  The details of the measurement are different since the bottom is 
solid (or nearly so) compared to the water.  The BroadBand ADCP Primer 
also has additional details concerning how bottom tracking operates. 

9.1 Velocity Profiles 
As the ADCP processes the signal reflected off the particles in the water, it 
divides the water column into a number of discrete segments stacked in the 
vertical.  These segments are called depth cells.  The ADCP determines the 
velocity and direction of each depth cell.  If we graph the velocity as a func-
tion of depth, we get a velocity profile from near the surface to near the bot-
tom.  The thickness of the depth cells is something that you get to select 
(within certain constraints set by the instrument’s design and the laws of 
physics).  With a 1200 kHz ADCP these depths cells can be as small as 5 
cm, or 10 cm for a 600 kHz system.  So in water a few meters deep, you can 
make many simultaneous velocity measurements in the vertical dimension.   

 
Figure 32. Velocity as a Function of Depth 
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9.2 Bottom Track 
When water profiling, the ADCP measures the speed and direction of the 
water relative to the ADCP.  So, an ADCP moving north at 1 m/s in calm 
water or water flowing south at 1 m/s past a stationary ADCP will both pro-
duce the same output from the ADCP for water velocity (see Figure 33).  
An ADCP moving north at 1 m/s through water flowing south at 1 m/s 
would produce an apparent water velocity of 2 m/s toward the south.  The 
ADCP bottom track measures the speed and direction of the bottom motion 
relative to the ADCP.  By subtracting the ADCP velocity from the apparent 
(relative) water velocity, the true velocity of the water (with respect to the 
bottom) is determined.  

Water Stationary
Vb = 1m/s
NORTH Apparent velocity = 1 m/s South

Boat Stationary
Vw = 1 m/s

Water Speed

Apparent velocity = 1 m/s South

Vb = 1m/s
NORTH

Apparent velocity = 2 m/s South
Vw = 1 m/s

Water Speed

 
Figure 33. Boat versus Water Velocity 

9.3 Other Data 
The ADCP also records several other pieces of information that are related 
to the measurement of the velocity of the water.  These are briefly described 
below. 

Temperature.  The ADCP has a sensor in the transducer head to measure the 
temperature of the water at the ADCP.  Measurement of the velocity of the 
water (and the bottom) depends on the speed of sound in the water at the 
ADCP.  The ADCP uses the measured water temperature along with a user-
input value of salinity to calculate the sound speed. 

Compass.  The ADCP has a flux-gate compass that measures the orientation 
of the ADCP relative to the earth’s magnetic field.  If you have requested 
earth coordinates for data collection (EX-command) the compass data will 
be used by the ADCP to output velocities in earth coordinates. WinRiver 
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will use the heading information to transform the raw data to earth coordi-
nates before display if it has been collected in beam, instrument or ship 
coordinates.  

Pitch and Roll.  The ADCP also has pitch and roll sensors.  These allow ei-
ther the ADCP or the WinRiver software to correct the velocity measure-
ments for rocking or tilting of the ADCP. 

Intensity.  The ADCP also records the intensity of the acoustic echoes re-
ceived back from the energy scattered off the particles suspended in the wa-
ter.  This information is useful for verifying ADCP operation.  It also pro-
vides a visual display of how sediment backscatter is distributed.   

Correlation. The amplitude of the correlation function, in each depth cell, 
output by the ADCP is quality assurance for your data. 

ADCP Percent Good. The ADCP can average data from individual pings in-
ternally to create ensemble data before sending it out.  If for some reason, 
one ping of the ensemble has bad data, that information is not used in the 
average.  Single ping ensembles are recommend, and in this case, the per-
cent-good will be 100% (good data) or 0% (bad data). 

Transect Percent Good. WinRiver presents a percent good value that is dif-
ferent from that in the raw ADCP data.  Within WinRiver, this value repre-
sents the percentage of discharge calculations that are valid in a particular 
depth cell. 

Real-time Clock.  The ADCP has a real-time clock that measures time to 
0.01-second precision and is accurate to within a few seconds per month for 
operating temperatures between 5 and 40 degrees Celsius.  The date and 
time of a ping or ensemble is output as part of the data.  The time between 
ensembles multiplied by the boat velocity is the displacement of the boat 
between ensembles.  This is used to compute the discharge as well as to plot 
the boat trajectory. 
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10 Discharge Measurement Basics 
A typical discharge measurement is calculated from several transects of 
data.  Referring to Figure 34, a transect goes across the river from point A 
to point B, and the total discharge (∑Q1) is recorded.  A second transect is 
then made starting at point B and ending at point A, and the second total 
discharge (∑Q2) is determined.  Continue this process until you have the 
desired number of transects.  An even number of at least four transects is 
recommended to calculate the discharge at a site.  The actual river discharge 
estimate will then be the average of the N individual transect discharge val-
ues (see equation 1).   

 
N

QQQQ
Q

...)( 4321 +Σ+Σ+Σ+Σ
=Σ  ( 1 ) 

 

 
Figure 34. Transect Path 

10.1 Path Independence 
Discharge is the accumulated flow crossing perpendicular to the boat’s path 
(see Figure 35, page 102).  Any arbitrary line can define the cross-section 
across the river.  It does not need to be straight across the river.  The ADCP 
measures the actual path of the boat from the change in the boat’s position.  
As well, it measures the flow across the path throughout the water depth. 
You do not need tag lines or even try to steer a straight course.  This makes 
it much easier and safer to obtain a discharge measurement, particularly at 
high flood stages or at sites with high traffic or wide channels. 

The WinRiver software calculates the discharge using this information.  
WinRiver can replace bottom tracking by using GPS data to measure the 
boat velocity and an external depth sounder to measure water depth. 
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Figure 35. Discharge Calculation is Independent of the Boat’s Path 

10.2 Directly Measured Flow and Estimated Regions 
The ADCP measures most of the water velocity from just in front of the 
ADCP to 6% above the bottom. At the channel edges, where the water is 
very shallow, the water depth is too shallow for the ADCP to profile.  The 
WinRiver software will estimate the discharge in these regions using several 
input values from the user.  Each of these unmeasured regions will be dis-
cussed below.  Refer to Figure 36, page 103 for an illustration of the un-
measured areas. 
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Figure 36. Unmeasured Regions in the Water Column 

10.2.1 Near Surface Region 
ADCP Depth.  The acoustic transducers of the ADCP need to be completely 
covered with water.  A typical transducer depth is around 20 cm, which will 
totally immerse the ADCP.  This allows reasonable boat speeds before air is 
pulled beneath the transducer (which blocks the acoustic energy from get-
ting into the water) and allows for some rocking of the boat.  In calm water, 
you may be able to put the ADCP less deep and you may need to put it 
deeper if the water is rough or very fast. 

Blank After Transmit.  The same transducer is used to receive the acoustic 
energy after transmitting a pulse.  A short time (or a short sound travel dis-
tance) must pass before receiving is possible.  This delay is called the 
blanking distance, and it allows the ADCP to ring down and become acous-
tically quiet before receiving the return signal.  For the 600 kHz and 1200 
kHz Rio Grande ADCPs, this distance is 25 cm.   

Pulse Structure – Lag.  For general profiling (mode 1), the acoustic pulse 
sent out is actually two or more distinct pulses that are closely spaced.  The 
spacing is called the lag.  One lag is required beyond the blanking distance 
to start processing the data in the first bin.   

The distance below the surface to the middle of the first cell for Mode 1 
general purpose profiling is the sum of the ADCP depth, the blanking dis-
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tance, and (bin +transmit length + lag)/2.  For a 600 kHz ADCP in mode 1 
with 50-cm depth cells, the distance to the top of the first depth cell is about 
90 cm (see Table 16, page 113).  The ADCP and the software will automati-
cally calculate this distance for you (you have to tell the software the depth 
of the transducer). 

10.2.2 Bottom Region 
Side Lobes.  There is also a shallow layer of water near the bottom for 
which the data is not used to compute discharge.  When the ADCP sends 
out an acoustic pulse, a small amount of energy is transmitted in side lobes 
rather than in the direction of the ADCP beam.  Side lobe reflection from 
the bottom can interfere with the water echoes.  This gives erroneous ve-
locities for the water near the bottom. WinRiver does not use data in the re-
gion that may be affected.  The ADCP has beams oriented at 20 degrees 
from the vertical, and the thickness of the side lobe layer is 6% of the dis-
tance from the transducers to the bottom (see Figure 37). 

BOTTOM SURFACE

SID
E LO

BE

20 DEGREE
BEAM ANGLE

6%

94%

ADCP

 
Figure 37. Side Lobes 
Pulse length.  WinRiver also does not use any data within one depth cell of 
the bottom or the side lobe layer.  The reason is that in the last depth cell, 
energy at the front of the pulse is reflecting off of the bottom while energy 
at the rear of the pulse is reflecting off of the water.  The energy reflected 
from the front of the pulse contaminates the reflection from the rear of the 
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pulse.  So, no data from within the 6% side lobe layer plus one depth cell 
from the bottom is used. 

10.2.3 Channel Edges 
Minimum Depth.  From the discussion of the top and bottom layers, you 
have probably deduced that there is a minimum depth in which you may 
acquire meaningful data.  As you approach the sides of your channel, the 
water will become too shallow for the ADCP to make a valid measurement. 
The edges are determined by the last segment to have two valid bins and 
bottom track. 

10.3 Computation of Discharge 
Measured Flow. WinRiver computes the discharge from the first depth cell 
to the last good cell not affected by the bottom or side lobes.  But what 
about the discharge in the top layer that isn’t measured at all, the layer 
above the bottom that isn’t used because of effects due to the bottom, and 
the edges that are too shallow to obtain a valid measurement?  The dis-
charge in these regions is extrapolated from the good data that was meas-
ured. 

Extrapolation: Top and Bottom.  The extrapolation of the discharge (see 
Figure 38, page 106) in the top and bottom layers can be done two ways 
with WinRiver.  One-way is to use the velocity from the depth cell closest to 
the surface or bottom as the velocity across the missing region: this is called 
constant extrapolation.  The other technique is to fit a power law curve to 
the data in the good part of the profile and extend the curve to the bounda-
ries.  The power law method for the top and bottom portion is a good choice 
for typical flow conditions. You can select the exponent in the power law 
method to get the best fit to the profiles in your channel.  The formulas de-
scribing the details of the extrapolation are provided in the WinRiver help 
file. 
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Figure 38. Discharge Extrapolation Method 
Extrapolation: Sides.  WinRiver includes a method to estimate the side dis-
charge using the data from the ensemble closest to the shore on either side.  
This is not done while you are acquiring the data but at a later time when 
you play back the data. WinRiver uses the user supplied edge distances in 
estimating the side discharge.  Again, the details of the calculations are in 
the WinRiver help file.  You will learn the actual procedure later in this 
manual. 

Extrapolation: Bad velocity bins.  As WinRiver calculates the discharge 
through the water column (Middle measured discharge), the bins with bad 
velocities are noted.  After the power fit is computed, these bins are “re-
filled” using the fitted power curve and accumulated into the “Mid Q” total 
discharge.   

Examining the discharge profile will identify the bins with estimated dis-
charge.  That is, anywhere there is a discharge value in a bin and there is not 
a corresponding good velocity for that bin, the discharge was estimated. 
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11 ADCP Commands 
These commands are contained in the Direct Commands portion of the 
WinRiver configuration file.  These commands are added to the configura-
tion file in the Setting menu, Configuration Settings, Commands Tab.  
When the Acquire mode is first started, these commands are sent by Win-
River to the ADCP to set its profiling parameters.  In the following, we will 
describe each command and give guidelines for setting these commands for 
acquiring reliable discharge data.  Refer to the WorkHorse Commands and 
Output Data Format Guide for more detailed information about each com-
mand. 

11.1 Send Commands to the ADCP 
a. Start WinRiver in the Acquire mode.  If you are in the Playback mode, 

click File, Acquire Mode. 

b. Click Setting menu, Configuration Settings, Commands Tab.   

c. Enter the commands in the User Commands box.   

d. Save the Configuration file by clicking, File, Save Configuration File 
or File, Save Configuration File As to save the file as a unique name. 

e. Click File, Start Pinging.  The Command Log window will open 
automatically and show the commands sent to the ADCP and the re-
sponse from the ADCP.  After the commands have been successfully 
sent, this window closes.   

f. To view this window again on the View menu, click Command Log.  
This will show the history of the dialog between WinRiver and ADCP. 

Water Mode (WM Command) 

Three modes are available for water profiling in the Rio Grande and Work-
horse ADCPs with the High Resolution Water Profiling upgrade.  They are 
Water Modes 1 (all ADCPs), 5, and 8.  Each mode has its own envelope of 
operation.  Mode 1 is the general-purpose mode, and should be used for 
most flow conditions.  Modes 5 and 8 are the high-resolution modes, and 
they are for use in shallow water with relatively low velocities. 
Maximum Bottom Depth (BX Command) 

Set the maximum bottom tracking depth (BX-command) to 50% greater 
than the maximum expected depth. This will keep the ADCP from trying to 
search deeper than a realistic bottom depth.   

 
NOTE.  The maximum bottom tracking range is 98 m for the 600 kHz and 
28 m for the 1200 kHz in water with 10°C temperature and 0.0 ppt salinity. 
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Depth Cell Size (WS Command) 

This command sets the length of the water for one cell measurement.  Refer 
to Table 16, page 113 for recommended settings.  The cells size range is 
0.10– 8 m (WS10 to WS800) for the 600 kHz and 0.05– 4 m (WS5 to 
WS400) for the 1200 kHz. 
Number of Depth Cells (WN Command) 

Set the number of water profiling depth cells (WN command) to cover the 
maximum expected water depth plus 2 additional cells.  As a rule of thumb, 

WN = Maximum Expected Depth (in centimeters) / WS + 2 
Blanking Distance (WF Command) 

The blanking distance should be set to 25 cm (WF25) to maximize the 
ADCP performance and minimize the unmeasured layer thickness at the 
surface.  If you see trouble in your data, try doubling the blanking distance. 
Pings per Ensemble (WP and BP Commands) 

Single ping ensembles are recommended for performing discharge meas-
urements (WP1 and BP1).  Averaging in either space or time can be done to 
the data by WinRiver while collecting data in the ACQUIRE module or later dur-
ing post-processing in the PLAYBACK module to reduce the standard deviation 
of the velocity measurements. The advantage of having the WinRiver soft-
ware do the averaging rather than the ADCP is that the raw data remains 
unchanged and you have the flexibility to vary the averaging interval to suit 
your application.   
Ensemble-Out Data (WD Command) 

This command selects the types of data collected by the ADCP.  The default 
setting is WD111100000, which tells the ADCP to collect velocity, correla-
tion magnitude, echo intensity, and percent-good status data.   

If you want to maximize your ping rate, you can do so by reducing the 
amount of data that must be transferred serially for each ensemble.  To do 
this, you can choose not to record percent-good status by selecting 
WD111000000. 
Mode 1 Ambiguity Velocity (WV Command) 

The Mode 1 ambiguity velocity represents the maximum relative velocity 
(ADCP motion plus the maximum actual water velocity) the ADCP can 
measure along a beam.  This must be set correctly to avoid ambiguity er-
rors.  The default value of 170 cm/s (WV170) corresponds to a horizontal 
relative velocity of about 5 m/s, and the maximum ambiguity velocity of 
480 cm/s (WV480) corresponds to a maximum relative velocity of 15 m/s.  
Use the default ambiguity velocity for most applications.  If you plan on 
using Mode 1 in flows faster than 5 m/s, use the following formula to set 
WV. 
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WV = Maximum Relative Water Velocity x sin (Beam Angle) x 1.5 

Where Beam Angle = 20° for the Rio Grande ADCP  
Mode 5 and 8 Ambiguity Velocity (WZ Command) 

The ambiguity velocity for modes 5 and 8 is set using the WZ command.  
The default value is WZ05, and this value should be used for all moving 
boat applications.  
Time Between Pings (TP Command) 

The TP command sets the time between pings, and ensures that you will not 
have ping-to-ping interference.  This value should be set to 0.2 seconds  
(TP000020) for the 600 kHz system and 0.05 seconds (TP000005) for the 
1200 kHz system.  These values were determined by considering the travel 
time for the bottom track ping to travel to its maximum possible range. 
Sensor Source (EZ Command) 

The EZ-command selects the source of environmental sensor data.  The Rio 
Grande default value is EZ1011101, which tells the ADCP to use internal 
heading, pitch, roll, and temperature sensors. 
Coordinate System (EX Command) 

There are four different coordinate systems that can be used for ensemble 
averaging: beam, instrument, ship, and earth.  Refer to the EX-command in 
the WorkHorse Commands and Output Data Format Guide for a description 
of each of the coordinate systems.  We recommend using ship’s coordinates 
for your measurements.  We recommend 4-beam solutions only because an 
error velocity will be calculated and presented for each ADCP ensemble.  If 
you have consistent trouble with bottom tracking or are working in a loca-
tion where one beam will be masked due to dam walls or pier pilings, mod-
ify the EX command to EX10111 to allow for 3-beam solutions. 

WinRiver transforms the raw data to earth’s coordinates before displaying it 
in either the Acquire or Playback modes.  This transformation does not 
change the contents of the original raw data file.   
Salinity (ES Command) 

It is critical to set the salinity (ES command) to the proper value.  All of the 
velocities and distances measured by the ADCP are proportional to the 
speed of sound.  If ES is set to the wrong value, it can produce an error in 
the calculated discharge.   

WinRiver can re-scale the raw ADCP data to correct for the speed of sound 
if the ES0 command was set incorrectly in the configuration file when the 
data was collected.  The re-scaled data displayed by WinRiver will reflect 
the corrected sound speed, though the raw data file will not be corrected.   
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NOTE.  The discharge calculated using 35.0 ppt is 8-10% higher than the 
discharge calculated using 0.0 ppt.  If you obtain discharge values that are 
consistently too high by this margin, check the salinity setting in WinRiver. 

 

Transducer Depth (ED Command) 

This value is used by the ADCP to calculate the speed of sound at the trans-
ducer face.  It is not necessary to set the command if the ADCP depth is less 
than five meters. The default value is ED000.  Enter the depth value in 
decimeters.  For example, a 10-meter transducer depth would be entered as 
ED100.   

11.2 WinRiver Processing Settings 
These settings affect how the raw ADCP data is displayed and how the dis-
charge is calculated within the Acquire and Playback modes.  They do not 
affect the raw data.  When you play the data back, the velocities, depths, 
and discharge values will reflect whatever processing settings are contained 
in the loaded configuration file.   
ADCP Depth 

Set the depth of the ADCP transducer faces below the surface (see the 
“Offsets Tab,” page 32).  The depths of the ADCP data presented in Win-
River will be determined from this value.  If you need to re-scale your ve-
locities within WinRiver by recalculating the sound speed, WinRiver will 
use the ADCP depth and the salinity you have entered along with the tem-
perature measured by the ADCP to calculate a new sound speed value for 
each ensemble. 
Magnetic Variation (Declination) 

Use a chart to determine the local magnetic variation in your area (see the 
“Offsets Tab,” page 32).  If there is an eastern variation in your area, the 
output of the ADCP’s magnetic compass when pointed to true North will 
read less than 360°.  If the local variation is to the West, the magnetic com-
pass will read greater than 0° if pointed to true North.  East variations are 
positive (entered as 12.5°°°°) and West variations are negative (entered as –12.5 
°°°°).  The magnetic variation value does not affect the calculated discharge 
unless you are using GPS.  This is because both the water velocity and the 
boat velocity (from bottom tracking) are measured in the same coordinate 
system (ADCP magnetic compass), while GPS positions are reported in true 
earth coordinates.  If you are using GPS, you must do the Magnetic Varia-
tion correction (see “Magnetic Variation Correction,” page 66). 
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Speed of Sound 

The Speed Of Sound box lets you correct velocity data for speed of sound 
variations in water. WinRiver can make these corrections dynamically with 
every ping or use a fixed speed of sound value (see the “Processing Tab,” 
page 34).  This setting directs WinRiver to one of three choices: 

• Use ADCP Value – (recommended setting) this setting will per-
form unity scaling to the raw ADCP velocities.  The sound speed 
calculated by the ADCP using the ED, ES, and temperature 
measured at the ADCP transducer head will be used for Win-
River data display.  When the ADCP depth is less than five me-
ters the sound speed calculation is not significant and it is not 
necessary to set the ED command. 

• Calculate for Each Ping – WinRiver will use the salinity and 
transducer depth values entered in WinRiver along with the 
ADCP measured temperature to calculate a new sound speed for 
each ensemble.  The new sound speed will be used to scale the 
velocities in each ensemble before display. Note: changes only 
affect the processed data, not the raw data.   

• Fixed – WinRiver will use this fixed value to scale the raw ADCP 
velocities for display on the screen.  Again, changes only affect 
the processed data, not the raw data. 

Backscatter 

The sound absorption coefficient is used to estimate the relative backscatter 
in dB (decibels) (see the “Processing Tab,” page 34).  The relative backscat-
ter when expressed in dB is a measure of the intensity of the returning echo 
from the scatterers.  It is a function of sound absorption, beam spreading, 
transmitted power, and the backscatter coefficient.  The sound absorption 
coefficient itself is dependent on frequency, temperature, and salinity. 
Data Screening 

Select Mark Below Bottom Bad to mark data below the ADCP-detected 
bottom or Depth Sounder detected bottom (if selected for processing) (see 
the “Processing Tab,” page 34).  Check the Use 3 Beam Solution for BT 
box to allows 3-beam solutions if one beam is below the correlation thresh-
old set by the BC command.  Check the Use 3 Beam Solution for WT box 
to allows 3-beam solutions if one beam is below the correlation threshold 
set by the WC command.   

 

NOTE. The Mark Below Bottom Bad setting only affects the data dis-
play.  Cells below the bottom and those within the side lobe layer are 
never used in the discharge calculation. 
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Thresholds 

The ADCP uses these parameters to determine good data.  If the ADCP’s 
data value exceeds these thresholds, it flags data as bad for a given depth 
cell (see the “Processing Tab,” page 34).   
Extrapolation Method 

• Top and Bottom Discharge Method – two methods, Power or 
Constant, are provided to extrapolate the discharge in the upper 
and lower layers of the water that are not directly measured by 
the ADCP (see the “Discharge Tab,” page 37).  Constant ex-
trapolation uses the velocity at the nearest depth cell for the re-
mainder of the water column.  Power extrapolation fits a power 
curve to the directly measured portion of the water column, and 
then uses that power law fit to compute the discharge in the un-
measured portions.  The details of both computations are docu-
mented in the WinRiver help file.  A good starting point is to use 
power for both the top and bottom layers. After you have taken 
some data on one of your channels, you can see how good the 
power law fit actually is by looking at the Profiles, Discharge 
display in Playback.  You can then try other exponents in play-
back to attempt to improve the fit.  

• Power Curve Coefficient – this value is used in the power extrapo-
lation fit.  An exponent of 0.1667 (1/6th power law) is a theoreti-
cal solution for open channel flow.  For more information on the 
theory of power law for flow resistance see Chen, Cheng-Lun, 
“Unified Theory on Power Laws for Flow Resistance”, Journal 
of Hydraulic Engineering, Vol. 117, No. 3, March 1991, 371-
389. 

• Left/Right Bank Edge Type – Use this field to describe the geome-
try of your edges.  Choose Triangular, Square, or a user-
specified Coefficient. 

Velocity Reference 

Use the Settings menu, Reference to set the velocity reference (see 
“General Preferences,” page 4).  Bottom Track should always be used for 
river measurements from a moving vessel.  With this setting, true water ve-
locities will be presented in the WinRiver displays because the boat velocity 
has been subtracted from the relative velocities measured by the ADCP.  If 
None is chosen as the velocity reference, relative velocities will be dis-
played. 
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12 Water Profiling Modes 
This section explains all of the water-profiling modes available for the 
Workhorse Rio Grande and Mariner ADCPs and Workhorse ADCPs with 
the high-resolution water profiling upgrade installed.  For each mode, we 
provide a general description, an explanation of the best place to use this 
mode, specifics about the mode, and any setup considerations.  Use 
Table 16 as a guide for choosing the appropriate mode for your water flow 
conditions.  Some details are contained here but not all.  As RDI learns 
more from your experiences, we will be able to add information to help you 
better collect data. 

Table  16: Workhorse River Water Modes 
 Mode 1 Mode 5 Mode 8 

Typical application Fast water of all 
depths.  Rough 
and dynamic 
situations.  Good 
in streams too fast 
or deep for modes 
5 & 8.  

Slow, shallow 
streams with 
velocities < 0.5 
m/sec with low 
shear and/or 
turbulence.   

Shallow streams 
with velocities       
< 1 m/sec and with 
moderate shear 
(rough bed) and/or 
turbulence.  Works 
in shallow water 
where mode 5 
does not work well. 

Minimum 
recommended cell 
size (meters) 

0.50* 
0.25 

0.10 
0.10 

0.10 
0.10 

Recommended Cell 
Size (meters) 

0.50 
0.25 

0.25 
0.10 

0.25 
0.10 

Single ping standard 
deviation (cm/s) 
(using rec. cell size) 

18.0 
18.0 

0.3 
0.4 

5.2 
7.8 

First range cell 
(meters) 

0.87 
0.56 

0.50 
0.35 

0.50 
0.35 

Minimum profiling 
range (meters) 

1.7 
1.0 

1.6 
0.9 

0.9 
0.6 

Maximum profiling 
range (meters) 

45 
12 

7.0 
3.5 

7.0 
3.5 

Maximum relative 
velocity (m/s) 

10 m/sec 0.5 m/sec 1 m/sec 

* 600 kHz values are in bold font, and 1200 kHz values are in regular font.   
Specifications are for 25 cm blank, 10° C temperature, and 0.0 ppt salinity.  
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NOTE.  The ranges in Table 16, page 113 are measured from the 
transducer face.  Add the transducer depth to determine the actual 
minimum and maximum profiling depths. 

 

 

NOTE.  Maximum range depends on water temperature and depth cell 
size.  Use PLAN to compute the maximum range for a particular ADCP set-
up and water temperature.  The standard deviation of modes 5 & 8 varies 
with water speed, boat speed, bed-form roughness, channel depth, and 
turbulence.   

 

12.1 General Purpose Profiling - Mode 1 
General Description - This is our most robust mode of operation. It allows 
for good data collection in all environments.  

Best Use Areas - Mode 1 is good for all areas. It works well in areas of slow 
currents, turbulent currents, strong shears, low backscatter concentrations 
(or where signal returns are apt to be weak), high background noise (such as 
being used from a ship), and in areas where the water changes from shallow 
(1 m) to deep (>6 m). 

Specifics - The standard deviation determined by the bin size (WS 
command) and the ambiguity velocity (WV). The ambiguity velocity tells 
the ADCP what maximum velocity it will see. If you are operating the 
ADCP from a moving platform, the maximum velocity would be the 
ADCP’s maximum speed (motion through the water) plus the maximum 
water speed. We call this the maximum “apparent velocity” the ADCP will 
see. 

Setup Considerations - To set the Mode 1 ambiguity velocity correctly, you 
must have an idea of the maximum apparent velocity to set the WV com-
mand.  Use the following formula to set the WV-command:  

WV = (max. apparent velocity in cm/s) * (sin B) * (1.5) 

Where: 
• B = Beam angle (20 degrees for the Rio Grande) 

• (1.5) = Safety margin. You can reduce this safety margin if you 
are sure you will not exceed the maximum apparent velocity. We 
recommend a minimum safety margin of 1.1. 
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NOTE.  

The minimum suggested setting for the WV-command is 100 cm/s 
(WV100), which corresponds to an apparent horizontal velocity of 3 m/s. 

The default setting for the WV-command is 170 cm/s (WV170), which 
corresponds to an apparent horizontal velocity of 5 m/s. 

The maximum setting for the WV-command is 480 cm/s (WV480), which 
corresponds to an apparent horizontal velocity of 15 m/s.  Higher settings 
will produce bad velocity data. 

The values shown here do not include a safety factor.   
 

Table  17: Mode 1 Minimum and Maximum Profiling Ranges 
Profiling Range (m) Frequency Cell Size (m) 

Minimum Maximum 

0.50 1.7 45.0 

1.00 2.7 52.0 

2.00 4.8 60.0 
600 

4.00 9.0 67.0 

0.25 1.0 12.0 

0.50 1.6 14.0 

1.00 2.6 16.0 
1200 

2.00 4.7 18.0 
Specifications are for 25 cm blank, 10° C temperature, and 0.0 ppt salinity. 
 

 

NOTE.  The ranges in Table 17 are measured from the transducer face.  
Add the transducer depth to determine the actual minimum and maximum 
profiling depths. 

 

12.2 High Resolution Profiling - Mode 5 
General Description - Mode 5 is our high-precision, shallow-water mode. 
Mode 5 allows for very low standard deviation (less than 3 cm/s) in shallow 
water.  Mode 5 should be used with bottom tracking enabled. 

Best Use Areas - Mode 5 is ideal for shallow water with water currents less 
than 50 cm/s. 

Mode 5 is not good for areas where there is shear, turbulence, background 
noise, or fast ADCP motion (above 0.5 to 1 m/s). If high shears, turbulence, 
background noise, or fast ADCP motion occurs, the ADCP will not collect 
data. 



WinRiver User's Guide 

page 116 RD Instruments 

12.3 High Resolution Profiling - Mode 8 
General Description - Mode 8 is our medium-precision shallow-water mode.  
The standard deviation of Mode 8 is about 10 times greater than Mode 5 for 
the same size depth cell and water speed.  Mode 8 should be used with bot-
tom tracking enabled. 

Best Use Areas - Mode 8 is ideal for shallow water (8 m and less), where 
there is any shear, turbulence, background noise, or fast ADCP motion 
(maximum 1-2 m/s).  Mode 8 can be used in fixed measurements or slow-
moving platform measurements where the water velocity flows are very 
low.  However, Mode 5 is better suited for those areas. 

Note that if the shears, turbulence, background noise, or ADCP motion is 
too great, the ADCP will not collect data.  

12.3.1 Mode 5 and 8 Specifics 
Mode 5 and 8 use short encoded pulses that travels to the bottom, where it 
is reflected, and then back up to the ADCP.  When the signal is received at 
the transducer face, the ADCP transmits another pulse.  The ADCP knows 
how long to wait before sending the second transmission because Bottom-
Track measures the water depth.  For this reason, it is important to use bot-
tom tracking for downward-looking deployments. 

For Modes 5 and 8, two pulses are processed to create the velocity estimate.  
The standard deviation for Mode 5 and 8 is very low because there is a rela-
tively long lag between the two pulses.  Mode 5 estimates the velocity 
based on the Doppler shift, and its algorithm is sensitive to ambiguities.  
Therefore, this mode is highly sensitive to conditions with high shear, tur-
bulence, and fast ADCP motion.  Mode 8 makes the estimation based on a 
proprietary scheme.  Mode 8 has no ambiguity problems, and therefore it 
can operate in areas that Mode 5 cannot.  However the method of estimating 
velocity used by Mode 8 has a higher standard deviation as compared to 
Mode 5 operation.  Use an ambiguity velocity value of 5 cm/s WZ005 (lag 
setting) for most deployments to allow for the deepest possible profiling 
range.  The ADCP automatically adjusts this setting higher based on the 
depth of the water measured by bottom tracking. 

There are some applications where you may wish to obtain only valid data 
near the ADCP when the bottom is out of range of the system.  In these 
cases, the setting of WZ005 will still work.  It allows the system to collect 
data as deep as it can. 

The profiling range of the high-resolution modes is limited by two factors: 
(1) the very short encoded pulses used, and (2) the maximum velocity water 
velocity.  These pulses do not put much energy in the water, so the signal 
return is weak.  The deeper the profile, the slower the water must move or 



 WinRiver User's Guide 

P/N 957-6171-00 (June 2001) page 117 

an ambiguity error will occur.  Higher boat and water velocities will result 
in maximum profiling ranges that can be half of the values specified in 
Table 18, page 118. 

12.3.2 Comparision of Water Modes 5 and 8 
Water-Profiling Mode 5 

Mode 5 advantages compared to Mode 8 (see Table 16, page 113): 

• Mode 5 gives a lower single-ping standard deviation than Mode 8 
for the same size depth cell (bin) 

Mode 5 disadvantages compared to Mode 8: 

• A larger minimum profiling depth may be required than Mode 8 

• A reduction in the maximum velocity the ADCP can measure  

• Does not work well in dynamic water environments that have 
water velocity changes greater than 50 cm/s (e.g., eddies, shear) 

Water-Profiling Mode 8 

Mode 8 advantages compared to Mode 5 (see Table 16, page 113): 

• May be able to profile in shallower water the Mode 5 

• An increase in the maximum velocity the ADCP can measure  

• Works in dynamic water environments that have water velocities 
changes up to 100 cm/s (e.g., turbulence, eddies, shear) 

Mode 8 disadvantages compared to Mode 5: 

• The single-ping standard deviation is about 10 times greater than 
Mode 5 for the same size depth cell (bin) and relative water 
speed. 
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12.3.3 Mode 5 and 8 Minimum Profiling Range Capability 
Mode 5 and 8 must have a minimum water depth in order to profile. 
Table 18 shows the minimum profiling range as a function of system fre-
quency and cell size.  The minimum profiling capability is dependent upon 
cell size (WS) and the blanking distance (WF) for each system frequency.   

Table  18: Mode 5 and 8 Minimum and Maximum Profiling Ranges 
Profiling Range (m) 

Mode 5 
Profiling Range (m) 

Mode 8 Frequency Cell Size 
(m) 

Minimum Maximum Minimum Maximum 

600 kHz 0.10 0.9 7.0 0.6 7.0 

 0.25 1.6 7.0 0.9 7.0 

 0.50 2.2 7.0 1.4 7.0 

1200 kHz 0.10 0.9 3.5 0.6 3.5 

 0.25 1.6 3.5 0.9 3.5 
Specifications are for 25 cm blank, 10° C temperature, and 0.0 ppt salinity.  
Relative water velocity is 0.5 m/s for Mode 5 and 1 m/s for Mode 8. 
 

 

NOTE.  The ranges in Table 18 are measured from the transducer face.  
Add the transducer depth to determine the actual minimum and maximum 
profiling depths. 
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13 Troubleshooting 
Use the following suggestions to guide you if you are having trouble obtain-
ing reliable discharge data.  If you cannot arrive at a solution after trying the 
suggested solutions below, send a description of the problem, some example 
data files along with their associated configuration files, and a DumbTerm 
log file to your local representative or to RD Instruments via email. We will 
assist in analyzing the problem. 

Email: rdifs@rdinstrumets.com  

13.1 Why can't I see my data? 
If you do not see any data on contour plots or other displays during Play-
back mode, check the following items. 

• Mark Below Bottom "Bad" is selected in the Configuration 
Settings, Processing tab and you do not have valid bottom depth 
data.   

• Your reference data is not valid.  If your reference is GPS on the 
Settings, Reference menu and you did not have GPS active dur-
ing data collection; your data will always be invalid.   

• Check the contour or profile plots minimum and maximum depth 
axis is setup properly.  On the Velocity Tabular view, look at the 
left column where the depth of the water profile depth cells are 
displayed and set the minimum and maximum depth accordingly 
on the Configuration Settings, Chart Properties 1 tab.   

• On the Velocity Tabular view, if you see negative depths, your 
system is up-looking and you need to adjust the ADCP Trans-
ducer Depth on the Configuration Settings, Offsets tab.   

• The data is not present.  Check the commands sent to the ADCP 
on the Configuration Settings, Commands tab. For example, 
sending WD 110 100 000 will override the default WD 111 100 
000 command and tell the ADCP to not collect echo intensity 
data.  This will result in displaying "Bad" on Tabular views and 
not displaying at all on contour or profile plots.   
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13.2 Lost Ensembles 
If the Number of lost ensembles on the Standard and/or Composite Tabu-
lar views starts to increase, it may indicate a problem with the communica-
tions setup between the ADCP and WinRiver.  You may have the serial 
communications speed set too high for your computer or you are inadver-
tently holding a key down too long.  Since a computers keyboard has a 
higher priority than its serial port, serial data can get lost if the keyboard is 
used too long at the same time that serial data is being received.  One solu-
tion is to minimize the amount that you use the keyboard while the com-
puter is receiving data from the ADCP.  Another solution is to lower the se-
rial communications speed of the ADCP and the computer; this reduces the 
computer’s load with respect to serial port processing.  A third option is to 
use a computer equipped with a 16550 UART, which buffers the serial port, 
allowing the computer to keep up with the flow of data.  

To change the ADCP and computer baud rate, use DumbTerm to communi-
cate with the ADCP.  Send a CB-command with the desired baud rate value 
(see the WorkHorse Commands and Output Data Format Guide).  Press F5 
to change the serial port baud rate to match the ADCP.  Enter CK to save 
the new baud rate for the ADCP.  This must be done before pressing END 
to send a Break signal or the ADCP will reset back to the default 9600-baud 
rate.  Press END to check the communications using the new baud rate. 

Another source of the problem is interference in the transmission of data.  
Try not to place the ADCP’s underwater cable near a generator, the engine, 
or other large electrical equipment.  Do not coil the ADCP’s underwater ca-
ble around large metal objects.  

13.3 Missing Depth Cell Data 
Missing depth cell data will be marked as bad in the data displays.  The data 
within these cells has not met echo intensity, correlation, or percent-good 
thresholds.  Bad cells do not generally effect a discharge measurement be-
cause discharge is extrapolated for missing bins. 



 WinRiver User's Guide 

P/N 957-6171-00 (June 2001) page 121 

13.4 Unable to Bottom Track 
If you are losing bottom track, indicated by “bad” bottom track velocities or 
no depth indicated, then one or more of the following is possible: 

• The depth set in the BX-command is not deeper than the maxi-
mum depth of the channel: increase BX and try again. 

• Change the EX10101 command to EX10111 to allow for 3-beam 
solutions. 

• If there are abrupt depth changes in your river channel, bottom 
track may have trouble locking on to the rapidly changing depths 
as you transect.  If you know where the abrupt changes are lo-
cated in your channel try to move slowly over these regions. 

• There is something blocking one or more of the beams.  It may 
be air being pulled below the transducer: try putting the ADCP 
deeper in the water.  Some kind of debris has become caught on 
near the ADCP and is interfering with the beams: check the 
ADCP and its mount to see if debris has become entangled on 
the ADCP.   

• The bottom has grass, weeds, brush, or other submerged ma-
terials that are disrupting the beams near the bottom: try mov-
ing to a different nearby location to see if the problem 
changes. 

• There is a high sediment concentration near the bottom, and 
there is not enough contrast between the suspended sediment 
layer and the actual bottom to determine the true bottom 
range. Some users have found success detecting the bottom in 
these conditions by substituting a lower frequency ADCP, i.e. 
a 300 kHz in place of a 600 kHz, but at some point the sedi-
ment concentration will be so high the ADCP won’t work. 

If you cannot get valid bottom track depths using the suggestions above, an 
echo sounder can be used in place of bottom tracking.   
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13.5 Biased Bottom Track Velocities 
If one or more of the following occurs, it is an indication of bias in the bot-
tom tracking data: 

• The course made good is longer than expected. 

• The shiptrack plot shows an upstream offset compared to the ac-
tual track taken by the boat.   

• If you hold station at a position in the channel, the shiptrack indi-
cates that you are moving upstream. 

The bias can be caused by two different environmental sources: 

• High sediment concentration in the water column (Water Bias) 

• Fluid layer of sediment flowing along the bed of the stream 
(Moving Bottom) 

These two environmental sources produce biased values for ADCP bottom 
track, which in turn will bias the discharge calculation.  The consequences 
of the these environmental sources and the biased ADCP bottom track are: 

• Discharge computed with the ADCP is biased low 

• The vessel track (shiptrack) is biased upstream 

 
NOTE.  The ADCP is not malfunctioning – but measuring the environment 
as designed. 

 

If you obtain biased bottom track data at your river site, you can use GPS as 
the velocity reference in place of bottom tracking as described in the section 
on “Integrating Depth Sounder, External Heading, and GPS Data,” page 57.  
WinRiver can calculate discharge in real-time using the GPS data in place of 
bottom track velocities. 

13.6 Inconsistent Discharge Values 
If the measured discharge is lower than expected and not reproducible to 
better than 5%, you may be experiencing one or more of the following con-
ditions: 

• Biased Bottom Track (see the previous section) 

• There are tidal or other time dependent factors affecting the dis-
charge. 

A small repeatable difference in discharge values can be expected between 
transects made going different directions across the channel.  This differ-
ence can be caused by several factors: 
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• Wind can cause the boat to heel causing the ADCP depth to be 
slightly deeper when traveling in one direction versus another. 

• The ADCP may be mounted so that it is shadowed from the flow 
when a transect is made with the ADCP on the downstream side 
of the boat.  Mounting the ADCP from the front of the boat may 
reduce the difference in discharge values between reciprocal 
transects. 

13.7 Trouble Profiling in High Turbidity Conditions 
In flows with very high sediment concentrations, the acoustic energy trans-
mitted by the ADCP into the water undergoes high levels of absorption.  
The ADCP will not receive enough returned energy to make valid velocity 
measurements.  In this case, the echo intensity profile will show the re-
ceived signal level reaching the noise floor before the bottom is encoun-
tered.  Some ADCP users have been able to successfully profile in these 
conditions by using a lower frequency system, i.e. a 600 kHz rather than a 
1200 kHz, or a 300 kHz rather than a 600 kHz. 

13.8 Trouble Profiling with Modes 5 and 8 
Modes 5 and 8 are designed for use in shallow and slow moving water, and 
though they provide reduced standard deviation over Mode 1, they are 
highly sensitive to shear and turbulence.  We strongly recommend Mode 1 
for most profiling conditions.  If you are having trouble profiling using 
Modes 5 or 8, review the section on “Water Profiling Modes,” page 113.  
Check that the maximum relative water speed (water plus boat speed) and 
profiling range do not exceed the limitations given in Table 16, page 113.  
Both Modes 5 and 8 must have a minimum water depth to profile.  These 
depths are listed in Table 18, page 118.   

If the relative velocity and minimum and maximum depth requirements for 
modes 5 and 8 are met, and you still cannot get reliable performance, there 
may be turbulence and shear conditions in your river channel which are 
causing these modes to fail.  You will need to profile using general purpose 
profiling Mode 1. 

 



WinRiver User's Guide 

page 124 RD Instruments 

NOTES 
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